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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©November 2012

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive

Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

EuP-Standby and Off Mode Power Consumption Statement:

Thefigures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode or standby mode:

« Standby Mode <2W
« Off Mode <1wW
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereis no guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

2NZ
Z_ S

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the

equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed bel ow, to reduce therisk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 3.42A (65 Watts) minimum AC/DC Adapter.

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-
COMMUNICATION LINE CORD

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIII

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Power Safety

The computer has specific power regquirements:

* Only use a power adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requiresa
steady, uninterrupted power supply. If you are unsure of your local power specifications,

consult your service representative or local power company.

e The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access

to acompatible outlet, have a qualified electrician install one.

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not

by itswire.

» Make sure the socket and any extension cord(s) you use can support the total current

load of all the connected devices.

» Before cleaning the computer, make sureit is disconnected from any external power

supplies (i.e. AC/DC adapter or car adapter).

cord if you are wet.

Do not plug in the power

Do not use the power cord if
it isbroken.

Do not place heavy objects
on the power cord.
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and

power cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

If you do not use the battery for an extended period, then remove the battery from the computer for storage.
Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

K eep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

\ A/
A&
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

SAE
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won'’t need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your documents are prepared.

\ A/
A&
Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your

agrwbnE

N o

computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.

Xl
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

Adjust the height of the chair and/or desk so that the keyboard is at or dightly below the level
of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

Use a chair with aback and adjust it to support your lower back comfortably.

Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

Take periodic breaks if you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

Stretch and exercise your body several times a day.

Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear devel ops contact your service center.

XVI
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,

card reader & ExpressCard), Touchpad & Mouse & Audio.

» Chapter 3 The computer’s power saving options.

» Chapter 4 Theinstallation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

Chapter 6  Instructions for upgrading your computer.

Chapter 7 A quick guide to the computer’s PC Camera, WirelessL AN, Fingerprint Reader, 3G, Bluetooth
and Trusted Platform (TPM) modules (some of which may be optional depending on your pur-
chase configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external

devices.

» Appendix B Information on the Control Center.

» Appendix C Information on the video driver controls.

» Appendix D The computer’s specification.

» Appendix E A guideto the Docking Station.

» Appendix F Information related to the Windows 8 operating system.

. |
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
torefer to “What to Install” on page 4 - 1, “BlIOS Utilities” on page 5 - 1 and “ Upgrading The Computer” on
page 6 - 1 in the reminder of the User’sManual. Y ou may also find the notes marked with a2 of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then

4 the information contained in the Quick Start Guide should be enough to get you up

Notes and running. Eventually you should try to look through all the documentation (more

_ detailed descriptions of the functions, setup and system controls are covered in the

ggfgsk taiﬁg?ﬁgoﬁfrﬂ remainder of the User’s Manual), but do not worry if you do not understand every-

above to find detailed | thing thefirst time. Keep this manual nearby and refer to it to learn as you go. You

information about the || may find it useful to refer to the notes marked with a # as indicated in the margin.

computer’s features. For amore detailed description of any of the interface ports and jacks see“ I nterface
(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If

your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3



Quick Start Guide

System Startup

Remove all packing materials.

Place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 135 degrees); use the other
hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

e\ e

4

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
1350 from the bottom right of
the Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

L_________________________________________________________________________________________________________________________________________________|
1 -4 System Startup
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System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 7 (with Service Pack 1 in-
stalled) and Windows 8 operating systems are supported.

The majority of this menu covers information covers information related to the Windows 7 operating system,
however for specific information on the Windows 8 operating system see Appendix F.

Note: In order to run Windows 7 (SP1) without limitations or decreased performance, your computer requires a
minimum 1GB of system memory (RAM).

4

Windows 7/8 OS

In order to run Windows 7 or 8 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 7 or 8 (64 bit) your computer requires a minimum
2GB of system memory (RAM).

System Startup 1-5
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Figure1-2
LCD Panel Open

=

Built-In PC Camera
(Optional)

PC Camera LED
LCD

Power Button

LED Indicators
Keyboard

Built-In Microphone
Touchpad &
Buttons

9. Fingerprint Reader
Sensor

©ONOOAWLN

Note that the Touchpad and
Buttons valid operational area
is that indicated within the red
dotted lines above.

System Map: LCD Panel Open
® o

1 -6 System Map: LCD Panel Open

N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations (or
WLAN Switch for wireless
LAN only) to toggle power to
the WLAN/Bluetooth and
3G modules, and check the
LED indicator or on-screen
icon to see if the modules are
powered on or not (see

/

).
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LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Icon Color Description Icon Color Description
Orange AC/DC Power is Plugged In Green The (optlor_lal) Wireless LAN Module
is Powered On
The Powered USB Port is On Win 7 - The (optional) Bluetooth
(System Off) - See Overleaf Module is Powered On
Blinking Orange - .
Orange The Camera is in Use Win 8 - The (optional) Bluetooth

Module is Installed (this is not a

(System On) power on/off indicator in Windows 8)

Green The Computer is On Ll) Blue Power Button
Blinking The Computer is in Sleep Green Hard Disk Activity
Green Mode
. . Number Lock Activated

Orange The Battery is Charging El Green (to activate press Fn & Num LK)
Green The Battery is Fully Charged Green Caps Lock Activated
Blinking The Battery has Reached —~ Green Scroll Lock Activated
Orange Critically Low Power Status (to activate press Fn & Scr Lk)

Table 1 -1 - LED Indicators

LED Indicators 1 -7
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Powered USB Port

The powered USB 3.0 port (see Figure 1 - 6 on page 1 - 13) may betoggled on /off by means of the Fn + Power
Button key combination. When the powered USB port is on it will supply power (for charging devices only,
not for operating devices) when the system is off but still powered by the AC/DC adapter plugged into awork-
ing outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices -
seepage 8 - 11).

. |
1-8 LED Indicators
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Keyboard >

The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See
Table1- 2, on page 1- 10 for full function key combination details and Appendix F If your keyboard is

Other Keyboards

for Windows 8 keyboard information. damaged or you just
want to make a

| | [ ] change, you can use
any standard USB key-

g‘grrr_:sz% s board. The system will

detect and enable it

automatically. Howev-

i er special functions/
hot-keys unique to the
Keypad system’s regular key-

board may not work.

Play/Pause Key

3G
Module Power
Toggle Key

NumLk & ScrLk

Figure 1 - 3 - Keyboard Hold down the Fn Key

/ and either NumLk or

ScrLk to enable num-
ber or scroll lock, and
check the LED indica-

Some software applications allow the number-keys to be used with Alt to produce special characters. tor for status.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Special Characters

Keyboard 1-9
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
Fn + Power .
Button Powered USB Port Power Toggle Fn+F7 Display Toggle
Brightness Decrease/
Fn + 3G Module Power Toggle* Fn + F8/F9 Increase
Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F10 PC Camera Power Toggle
Fn+F1 TouchPad Toggle Fn + F11 WLAN Module Power Toggle
Turn LCD Backlight Off Bluetooth Module Power
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+F12 Toggle
Fn+F3 Mute Toggle Fn + Number Lock Toggle
NumLk
Fn +F4 Sleep Toggle Fn + ScrLk Scroll Lock Toggle
Fn + F5/F6 VOIUTE Decrease/ Caps Lock Caps Lock Toggle
ncrease

Table 1 - 2 - Function & Hot Key Indicators

.|
1-10 Function/Hot Key Indicators
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Control Center

Pressthe Fn + Esc key combination to toggle the Control Center on/off. The Control Center gives quick ac-
cess to frequently used controls and enables you to quickly turn modules on/off. The Control Center in Win-
dows 8 works under the Desktop app and not under the Start screen, and does not feature the wirel ess/Bluetooth
buttons and Airplane Mode etc. (see page F - 15 for Windows 8 information).

4

Undocking

Click the Docking button
to hot undock the system
(if your computer sup-
ports hot undocking). An
Undock Complete mes-
sage will appear in the
taskbar when undocking
is complete.

Figure 1 - 4 - Control Center

Click on any button to turn any of the modules (e.g. TouchPad, Camera) on/off. Click on Power Conservation
M odes to switch between Performance, Balanced or Energy Star modes (see page 3 - 10). To remove the
Power Conservation Modes screen just click in ablank area of the icon or press a key on the keyboard. Click
on the buttons (or just click and hold the mouse button) to adjust the slider for Brightness/Volume. Click on
Display Switch and click to choose a display mode from the menu (see page C - 10).

Control Center 1 - 11
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Figure1-5
Front & Top Views
(with Optional
Docking Station)

=

WLAN Switch
LED Indicators
3. Docking Station
(Optional)

N

WLAN Switch

Use the WLAN Switch
(for Wireless LAN only)
to toggle power to the
WLAN module. The posi-
tion of the WLAN switch
governs the power status
of the WLAN module at
startup, and upon resum-
ing from a power saving
state (see

).

System Map: Front & Top Views

4

Docking

If your purchase includes the docking station, open the docking port cover latch and align
the computer with the placeholder on the docking station (see the accompanying docking
station for full details of the docking procedure).

1-12 System Map: Front & Top Views



System Map: Left View
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4

Multi-In-1 Push-Push Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Ports

USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. Note that
the USB 3.0 port requires a driver installation (see “USB 3.0 (Win 7 Only)” on page 4 - 7)
for Windows 7 (no driver is required for Windows 8) and is not operational under DOS.

The powered USB 3.0 port 6 can supply power (for charging devices only, not for op-
erating devices) when the system is off but still powered by the AC/DC adapter plugged
into a working outlet, or powered by the battery with a capacity level above 20% (this may
not work with certain devices - see page 8 - 11). Toggle power to this port by using Fn +
power button.

Quick Start Guide

=

P w

o

©o~No

Figure 1 - 6
Left View

DC-In Jack
External Monitor
Port

RJ-45 LAN Jack
e-SATA Port
1*Powered USB
3.0 Port

2 *USB 3.0 Ports
Fan Intake/Vent
HDMI Out Port
Multi-In-1 Card
Reader
ExpressCard Slot
(see page 2 - 4)

System Map: Left View 1 - 13
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Figure 1 - 7 System Map: Right & Rear Views

Right & Rear Views

1. Microphone-In

Jack
2. Headphone-Out 0 9 9 9

Jack
3. 1USB 2.0 Port
4. Optical Device

Drive Bay @
5. Security Lock 6

Slot

6. Battery _ZX_

7 \§

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption)
you may push the end of a straightened paper clip into the emergency eject hole. Do not
use a sharpened pencil or any object that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the system is accessing it. This may
cause the system to “crash”.

Disk Eject Warning

Don't try to eject a CD/DVD while the system is accessing it. This may cause the system
to “crash”. Stop the disk first then eject it, or press the stop button twice.

1-14 System Map: Right & Rear Views
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System Map: Bottom View Figure 1 - 8
Bottom View
o 7£l< Battery

CPU

The CPU is not a user ser-
viceable part.

Overheating

To prevent your computer Cover
from overheating make

sure nothing blocks the

Vent/Fan Intake while the

computer is in use.

Docking Port
Fan Intake/Vent
Speakers
Component Bay

aghrwNE

4

Battery Information

ﬁ Always completely dis-

charge, then fully
Docking Port Cover charge, a new battery
before using it. Com-

If your purchase option includes the docking station, make sure you keep the cover pletely discharge and
closed when the computer is not docked in the station. This will help prevent foreign objects charge the battery at
and/or dust getting in to the contact area. least once every 30 days
If your purchase option does not include the docking station, an insert will be provided or after about 20 partial
to prevent accidentally opening the docking port. Do not attempt to open the cover or re- discharges.

move the insert in this case.

System Map: Bottom View 1 - 15
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3G Module USIM Card Installation

If you have included an optional 3G module in your purchase option, follow the instructions below to install the

USIM card (which will be provided by your service provider), and then run the appropriate 3G application. See

“3G Module” on page 7 - 46 for instructions on installing the program etc.

1. Turn off the computer, and turn it over and then remove the battery (slide the latches in the direction indicated
below and slide the battery out).

2. Insert the USIM card into the slot at the rear of the battery compartment, as illustrated below, until it clicks fully
into position, and replace the battery.

dNZ
RS

USIM Card Orientation

Note that the USIM card’s readable side (with the gold-colored contacts) should face upwards (towards the top of the com-
puter) as illustrated.

Figure 1 - 9 - Battery Removal & USIM Card Insertion

1-16 3G Module USIM Card Installation
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Docking Port

Follow the instructions below befor e connecting the computer to the docking station, if included in your pur-
chase configuration. Failure to open the cover of the docking port before connecting the computer to the docking
station may result in irreparable damage to the connector on the docking station.

1. Turn the computer over.

2. Slide the docking port cover latch in the direction of the arrow at point Q to open the cover.

3. After disconnecting the computer from the docking station, slide the docking port cover latch in the direction of
the arrow at point @.

Docking Port
Cover

0 9 Make sure you keep
the cover closed

when the computer is
not docked in the sta-
tion. This will help
prevent foreign ob-
jects and/or dust get-

Figure 1 - 10 - Opening and Closing the Docking Port ting in to the contact
area.

.|
Docking Port 1 -17
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Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 are accessed from the Start menu (see Ap-
pendix F for information on the Windows 8 OS). When you install programs and utilities they will be installed
on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click
the Start menuicon , and then select Properties to customize the appearance of the Start menu.

Click here to toggle Category View

Figure 1 - 11 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
inWindows (e.g. power, video, network, audio etc.). Windows 7 provides basic controlsfor many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

. |
1-18 Windows 7 Start Menu & Control Panel
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Personalization) in Windows 7 (see over). For more detailed video information see “ Video Driver Con-
trols’ on page C - 1. To access Display (Control Panel) and Screen Resolution in Windows:

Click Start and click Control Panel.

Click Display (icon) - In the Appearances and Personalization category.

Click Adjust Screen Resolution/Adjust resolution.

Alternatively you can right-click the desktop and select Screen resolution.

Use the dropbox to select the screen Resolution @ (Figure 1 - 12).

Click Advanced settings @ (Figure 1 - 12) to bring up the Advanced properties tabs.

oukwbnpE

Figure 1 - 12 - Screen Resolution

Video Features 1 - 19
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To access the I ntel (R) Graphics and Media Control Panel:

1. Click Advanced settings @ (Figure 1 - 12 on page 1 - 19) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button) @ (Figure 1 - 13) in the Intel Graphics & Media Control Panel tab.

OR

3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Click the icon H e (Figure 1 - 13) in the taskbar and select Graphics Properties from the menu.
OR

5. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel in Classic View.

® )

C )

Figure 1 - 13 - Intel Graphics and Media Control Panel

1 -20 Video Features
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 18 or see Ap-
pendix F for information on the Windows 8 OS) allows you to configure power management features for your
computer. Y ou can conserve power by means of power plans and configure the options for the power button,
sleep button, computer lid (when closed), display and sleep mode from the left menu. Note that the Power
saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create anew plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options. Pay attention to the instructions on battery care in “ Battery I nformation” on page 3 - 11.

Figure 1 - 14 - Power Options

.|
Power Options 1 -21
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Features & Components

Chapter 2: Features & Components P

Overview External Optical
(CD/DVD) Device
Read this chapter to learn more about the following main features and components Drives

of the computer: : o
To install applications

and drivers etc. you will

* Hard Disk Drive need to attach an exter-
e Multi-In-1 Card Reader nal optical CD/DVD de-
e ExpressCard Slot vice to the USB ports.

» Touchpad and Buttons/Mouse
* Audio Features

For information on the Windows 8 operating system see Appendix F.

. |
Overview 2 - 1
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Hard Disk Drive

AL
’Q\ The hard disk drive is used to store your data in the computer. The hard disk can be
Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height

Before attempting to ac- of 9.5 mm.

cess any of the internal L .
Selee e o el Thehard disk isaccessible from the bottom of your computer as seen below. For fur-

O NEREEEREREREEM  ther details see “ Upgrading the Hard Disk Drive” on page 6 - 6.
that the machine is not

connected to the AC

power, and that the ma-

chine is turned off. Also

ensure that all peripheral

cables, including phone

lines, are disconnected

from the computer.

Figure2-1
Hard Disk Location

. |
2 - 2 Hard Disk Drive
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Multi-In-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“CardReader” on page 4 - 6.

« MMC (MultiMedia Card) / RSMMC

» SD (Secure Digital) / Mini SD / SDHC/ SDXC
* MS(Memory Stick) / MSPro/ MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the
cards.

4

Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

Push-Push Card
Reader

The card reader fea-
tures a push-in/push-out
card insertion and ejec-
tion mechanism. Simply
push the card to insert
and eject it, however Ms
Duo cards require an
adapter.

Figure2-2
Left View

1. Card Reader

Multi-In-1 Card Reader 2 - 3
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P ExpressCard Slot
The computer is equipped with an ExpressCar d/34/54 slot that reads Express Card/
Exf’resscard 34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Slot Cover Cards). Make sure you install the Card Reader driver (see” CardReader” on page 4
Make sure you keep the - 6).

rubber cover provided in ) o ] ) ]
the ExpressCard slot | EXxpressCard/54 is used for applications which require a larger interface sot, e.g.

when not in use. This | CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
will help prevent foreign § - nrecg Card/54 and 34mm for the ExpressCard/34.

objects and/or dust get-
ting in to the Express-

Card Slot.
_ (1
Figure2-3
Left View
1. ExpressCard Inserting and Removing ExpressCards
Slot » Align the ExpressCard with the slot and push it in until it locks into place (as

pictured in the generic figure below).
» Toremove an ExpressCard, simply press the card to gect it.

.|
2 - 4 ExpressCard Slot
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Touchpad and Buttons/Mouse

The Touchpad is an aternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The Touchpad buttons function in
much the same way as a two-button mouse.

Once you have installed the Touchpad driver (see “ Touchpad” on page 4 - 6) you
can configure the functions by double-clicking the Touchpad driver icon  in the
notification area. Y ou may then configure the Touchpad tapping, buttons, scrolling
(see sidebar), pointer motion and sensitivity options to your preferences.

.|
Touchpad and Buttons/Mouse 2 - 5

4

Touchpad Scrolling

This computer model se-
ries may feature different
Touchpad versions.

These Touchpads may
differ in their vertical
scrolling function in most
scrollable windows.

Some Touchpads require
sliding the finger up and
down on the right of the
Touchpad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
Touchpad to scroll the
window.

Figure2-4
Mouse Properties
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5 Gestures and Device Settings
. 4 The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
Show Video tion) on the surface of the Touchpad to perform specific actions to manipul ate doc-
You can get a clearer uments, objects and applications.
view of the gestures in- . . . i . .
volved by clicking the Y ou can configure the settings from the Device Settings tab in M ouse Properties:
Show Video option for 1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

each gesture item. .
g Click Mouse (Hardware and Sound).

2.
Select the gesture (Pinch 3. Click Device Settings (tab) and click Settings.
4

Zoom, Rotating, Three Use the menu tree on the left to access the user configurable settings.
Fingers Down and

Three Finger Flick) in the

Device Settings > Set- O
tings left tree menu

and click the Show Video

button to see the demon-
stration video.

For more details on any of O
the gestures see the help

in the lower part of the

right menu window.

Figure2-5
Mouse Properties -
Device Settings

2 - 6 Touchpad and Buttons/Mouse
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Smart Sense

The Smart Sense feature helps prevent operating the Touchpad by accident, by rec-
ognizing when your palmisresting onit or brushing its surface while you are typing.

Y ou can adjust the sensitivity of Smart Sense by moving the slider towards M ax (to

help remove undesired pointer movement or clicks) or Off (if it missesintended mo-

tions or taps).

Figure2-6
SmartSense

.|
Touchpad and Buttons/Mouse 2 - 7
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Figure2-7

Scrolling Gesture

4

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

Figure2-8
Zooming Gesture

Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
Touchpad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the Touchpad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

2 - 8 Touchpad and Buttons/Mouse
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another

finger near the middle of the Touchpad and slide it in a circular motion around the

stationary finger (clockwise or counterclockwise) to rotate the object.

Figure2-9
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with avariety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-sel ectable applications.

Figure2- 10
Flick/Press
Gesture

.|
Touchpad and Buttons/Mouse 2 - 9
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Audio Features

Y ou can configure the audio options on your computer from the Sound  control
panel in Windows, from the HD V Deck icon on the desktop or VIA HD Audio
Deck control panel |¥%| via v audio Deck .

4

Sound Volume
Adjustment

The sound volume level

Is set using the volume | The volume may also be adjusted by means of the Fn + F5/F6 key combination.
control within Windows

(and the volume func-

tion keys on the comput-

er). Click the volume

icon in the taskbar to

check the setting.

Figure2- 11
VIA HD Audio Deck

2 - 10 Audio Features
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Expert Mode will alow you to access more advanced configuration menus for "
Speaker, Microphone and Stereo Mix. ZX

Syncing Left & Right
Volume
Balance

If you wish to adjust the left
and right channel volume
levels separately, you will
need to adjust this from the
VIA HD Audio Deck in Ex-
pert Mode.

Click Speaker in VIA HD
Audio Deck (in Expert
Mode) and click the Sync
Left and Right volume
button (see left). You can
then adjust the volume slid-
ers independently (this set-
ting also controls the
Balance setting in the Win-
dows Sound control pan-
el).

Figure2- 12
VIA HD Audio Deck
(Expert Mode)

Audio Features 2 - 11
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

. . functions will vary slight-
agement conserves power by controlling individual components of the computer iy depending an your

(the LCD and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is

« The Power Sources best to refer to the user’s

* Turning On the Computer IMENE @i 7o EFeE
ing system.

« Power Plans

» Power-Saving States (Note: All pictures used

» Configuring the Power Buttons on the following pages

are from the Windows 7

* Power Conservation Modes
0S))

» Battery Information
For information on the Windows 8 operating system see Appendix F.

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enablesthe OS to set devicesinto low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see“How do | completely discharge the battery?”

on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 11.

3 - 2 The Power Sources
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow- Z
er button on the front panel. Forced Off

; ; If the system “hangs”,
When the computer is on, you can use the power button as a Stand by/Hibernate/ i s T 2 A o]

Shutplown hot-key button when it is pr&ssed_for Ic—ss than 4 seconds (pressing and | .y combination doesn't
holding the power button for longer than this will shut the computer down). Use || work, press the power
Power Optionsin the Windows control panel to configure this feature. button for 4 seconds, or

longer, to force the sys-
tem to turn itself off.

4
Power Button as
Shut Down Stand by or

Note that you should always shut your computer down by choosing the Shut Down com- Hibernate Button

mand from the bottom right of the Start menu in Windows. This will help prevent hard disk You can use the OS's

or system problems. Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).

Turning On the Computer 3 - 3
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4

Resuming
Operation

See Table3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-1
Power Plan
Advanced Settings
(Win 7)

Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

> >

3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High performance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered. The recommended Balanced power plan will balance power saving and per-

formance.
Figure3- 2
Click to Show/Hide Power Plans
additional
power plans

. |
Power Plans 3 - 5
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Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Win 7 uses the Sleep, Hiber nate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occursthe system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. Y ou should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

-

Power-Saving States 3 - 7
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Figure3-3
Start Menu Power
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Configuring the Power Buttons

Z The power/deep button (Fn + F4 key combo) and closed lid may be set to send the
Password computer in to a power-saving state. Click Choose what the power buttons do on
PTOEEEN the left menu in Power Options to bring up the menu.

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-4
Power Options
Define Power
Buttons

.|
3 - 8 Configuring the Power Buttons



Resuming Operation

Y ou can resume operation from power-saving states by pressing the power button,

or in some cases pressing the sleep button (Fn + F4 key combo).

Orange (AC/DC adapter)

Power Status Icon Color To Resume
Power Off Off Press the Power Button
Press the Power Button
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button

Display Turned Off

Green

Press a Key or Move the Mouse/Touchpad

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons 3 - 9

Power Management

4

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table3-1
Resuming
Operation
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Power Conservation Modes

el This system supports Energy Star power management features that place comput-
3 Power Conservation ers (CPU, hard drive, etc.) into alow-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting 1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
will result in maximum & 2 Click either the Performance, Balanced or Energy Star button.
power saving, but with 3. Click in a blank area of the icon or press a key on the keyboard to exit Power

the possible loss of Conservation Mode without making any changes.
some performance.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Figure3-5

Control Center

3 - 10 Configuring the Power Buttons
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Battery Information N
Follow these simple guidelines to get the best use out of your battery.

Y/ \§
Low Battery
Battery Power Warning

Y our computer’s battery power is dependent upon many factors, including the pro-  BWAE R SRR E A S S
grams you are running, and peripheral devices attached. You can set actions to be WA IR EEIEIEN
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from  [HEsiEES aE FACiElS

. . . dapter to th It
power plan Change plan settings > Change advanced power settings (see Figure ir asgfé ;Ourev\fgmpgtﬁf

3-1onpage3-4). erwise, the unsaved

. . . data will be lost when
Click the battery icon [ in the taskbar to see the current battery level and charge BT S e e

status.

Figure3-6
Battery Icon
(Taskbar) & Battery
Advanced Settings

.|
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Conserving Battery Power

Z * Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center « Lower the brightness level of the LCD display. The system will decrease LCD
The Windows Mobility brightness slightly to save power when it is not powered by the AC/DC adapter.

grf)r\',tigés :%ntéglsy ppa(;ﬁ: * Reduce the amount of time before the display is turned off.

of access forinformation | « Closewireless, Bluetooth, modem or communication applications when they are
on battery status, power

. not being used.
plans used and wireless
device status etc. » Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

Figure3-7
Windows Mobility
Center
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improveits performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see“ Removing the Battery”
on page6 - 3.

New Battery

Always completely discharge, then fully charge, anew battery (see“ Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. (Refer to“ LED Indica-
tors’ on pagel - 7 for information on the battery charge status, and to “ Battery
FAQ" on page 3 - 15 for more information on how to maintain and properly re-
charge the battery pack.)

.|
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Proper handling of the Battery Pack
ﬁ * DO NOT disassemble the battery pack under any circumstances
* DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

2N
Ik

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3-8
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3-9
Change Plan
Settings / Change
Advanced Power
Settings

.|
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure3- 10
Power Options
Advanced Settings -
Battery

* Low battery levels= 0%

» Critical battery Levels= 1%

* Low battery action = Do Nothing

 Critical battery action (On battery) = Shut Down
» Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4. Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of
the computer’ s subsystems. The system takes advantage of some newer hardware components for which the lat-
est versions of most available operating systems haven't built in drivers and utilities. Thus, some of the system
components won't be auto-configured with an appropriate driver or utility during operating system installation.
Instead, you need to manually install some system-required drivers and utilities.

See Appendix F for specific information on the Windows 8 operating system.

What to Install

The Device Drivers & Utilities+ User’sManual disc containsthe drivers and utilities necessary for the proper
operation of the computer. Table 4 - 1, on page 4 - 3 listswhat you need to install and it isvery important that
thedriversareinstalled in the order indicated (all drivers provided are for Windows 7 with Service Pack 1).

The procedures for installing drivers for the PC Camera, WirelessL AN, Security (Fingerprint & TPM). 3G
and Bluetooth & WL AN Combo modules are provided in “ Modules & Options” on page 7 - 1.

2N
Ik

Driver Installation & Power

When installing drivers make sure your computer is powered by the AC/DC adapter connected to a working power

source. Some drivers draw a significant amount of power during the installation procedure, and if the remaining battery ca-
pacity is not adequate this may cause the system to shut down and cause system problems (note that there is no safety issue
involved here, and the battery will be rechargeable within 1 minute).

What to Install 4 - 1



Drivers & Utilities

Driver In Stal | atl on 1. Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
Insert the Device Drivers & Utilities+ User’s Manual this order) which is the same as that listed in the
disc and click I nstall Drivers (button), or Option Driv- Drivers Installer menu below.
ers (button) to access the Optional driver menu. 2. Click to select the driver you wish to install, (you
should note down the drivers as you install them).
3. Follow the instructions for each individual driver

installation procedure as listed on the following
pages.

Figure4 - 1- Drivers Installer Screen 1
Figure4 - 2 - Drivers Installer Screen 2

. |
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Win 7 SP1/Win 8 Driver Page # Win 7 SP1/Win 8 Driver Page #
Chipset Page 4 -6 PC Camera Module Page 7 -3
Video (VGA) Page 4 -6 Wireless LAN Module Page 7 - 11
LAN Page 4 -6 Fingerprint Reader Module Page 7 - 35
CardReader Page 4 - 6 ?3((33 I;Ar(ii/(i?ilsenot required for Windows 8) Page 7 - 46
Touchpad Page 4 -6 Bluetooth & WLAN Combo Module Page 7 - 70
Hot Key Page 4 -7 l(?(;glu::r\):g ifgrsr:;)rrdag?sl-(r: icnhzﬂlccl)lgri/]ode) Page 7 - 77
USB 3.0 (Win 7 Only)

(USB 3.0 driver is not required for Page 4 -7 Trusted Platform Module Page 7 - 85
Windows 8)

MEI Driver Page 4 -7 Intel® Smart Connect Technology Page 7 - 99
Audio Page 4 -7 Intel® Wireless Display Application Page 7 - 103

Table 4 - 1 - Driver Installation

All drivers provided are for Windows 7 with Service Pack 1 or Windows 8 (see Appendix F for Win 8 infor -
mation).

Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updatesetc. (all updateswill includethelatest hotfixes
from Microsoft). See “ Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+" to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Drivers & Utilities

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. PC Camera, WLAN or 3G)
are ON before installing the appropriate driver.

Driver Installation 4 - 5
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click Llnstall Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 settings to the highest resolution.

LAN

Click 3.Install LAN Driver > Yes.

Click Install Driversand Software > Next.
Click the button to accept the license and click
Next.

Click Next > Install.

5. Click Finish.

6. The network settings can now be configured.

wnN R

e

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.
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Hot Key

1. Click 6.Install Hotkey AP > Yes.

2. Click Next > Next.

3. Click Finish > Finish to restart the computer.

USB 3.0 (Win 7 Only)

1. Click 7.Install USB 3.0 Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

MEI Driver

1. Click 8.Install MEI Driver > Yes.

2. Click (click the button to “Install Intele Con-
trol Center”) Next > Yes> Next > Next.

3. Click Finish.

Drivers & Utilities

Audio

1. Click 9.Install Audio Driver > Yes.

2. Click Next.

3. Click the button to agree to the license and
click Next.

4. Click Next > Next > Next.

5. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gect
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It isrecommended you now also install the I ntel Rap-
id Storage Technology driver (see”|RST Driver In-
stallation” on page 7 - 77 - required for AHCI mode
hard disks).
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4
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc., (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Click Windows Update (System and Security/
Security).

3. Click Check for updates (button).

4. The computer will now check for updates (you
need to be connected to the internet).

5. Click Install now (button) to begin checking for the
updates.

6. Click Install updates (button) to install the
updates.

Windows Experience Index

After the drivers are installed follow this procedure to

ensure an accurate rating from the Windows Experi-

ence I ndex (make sure the AC/DC adapter is plugged
in):

1. Click Sart, and click Control Panel.

2. Click Performance Information and Tools
(System and Security > System > Check the
Windows Experience I ndex).

3. Click “Ratethis computer/Refresh Now/Re-
run the assessment”.

4. The computer will take afew minutesto assess
the system performance.

5. Close the control panel.
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Optional Drivers

See the pages indicated in Table 4 - 1, on page 4 - 3 for the driver installation procedures for any modules in-
cluded in your purchase option.

Figure4 - 3 - Drivers Installer - Option Drivers Menu
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

. |
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Chapter 5: BIOS Utilities e

/ \Y

BIOS Screens

Overview

This chapter gives a brief introduction to the computer’s built-in software: NOte Hihat e 8108

screens  pictured on
these pages are intend-

If your computer has never been set up, or you are making important changestothe B EERGIRG RGN REEE
system (e.g. hard disk setup), then you should review this chapter first and note the JEElEREERERIE A Sl S
original settingsfound in Setup. Even if you are a beginner, keep arecord of the set- SI0S

tings you find and any changes you make. This information could be useful if your EESSS e

system ever needs servicing. ject to constant change
and revision, therefore

There is one general rule: Don’t make any changes unless you are sure of what you AR RIS CEiEl
screens may appear

aredoing. Many of the settings are required by the system, and changing them could Sty e e
cause it to become unstable or worse. If you have any doubts, consult your service BT R
representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.

.|
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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4

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If thesetools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keysto scroll up or down the page.

Theltem Specific Help onthe upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Ubtility — Copyright (C) 2012 American Megatrends Inc.

System Date

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will also change
these settings. Some applications may also alter data filesto reflect these changes.

Main Menu 5 - 5
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

System/Extended Memory: (Main Menu)
Thisitem contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/ BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

p Advanced Chipset Control

Figure5- 3
Advanced Menu

Advanced Chipset Control (Advanced Menu)

The sub-menu here alows you to adjust the Bluetooth Power Setting and enable/

disableIntel Virtualization Technology Support and USB 3.0 Port power/ Card
Reader/ExpressCard power/USB 2.0 Port power.

. |
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Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control)

Y ou can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

Intel Virtualization Technology (Advanced Menu > Advanced Chipset Control)
Intel(R) Virtualization Technology enables a CPU to act asif it were several CPUs
working in parallel in order to alow several operating systems to run at the same
time in the same machine.

USB 3.0 Power/ Card Reader Power / PCI Express Card Power /

Powered USB 2.0 Port Power (Advanced Menu > Advanced Chipset Control)
These menu items allow you to enable/disable power to the card reader, Express
Card or USB ports when required to do so in order to save power.

Intel Smart Connect Technology (Advanced Menu)

Smart Connect isatechnology that makes checks on web applicationsthat are open
even when the computer isin sleep mode, and thus allows updates to be made with-
out the need to turn the computer on. The sub-menus here allow you to enable/dis-
able the technology itself (ISCT Configuration).
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Intel Anti-Theft Technology (Advanced Menu)

Anti-Theft Technology, which is built-in to the processor of the computer, allows ﬁ
system administrators to render your computer useless to thieves by sending a poi- SATA Mode

son pillencrypted SM'S message over a 3G network etc. Administrators can also re-

motely unlock a recovered computer quickly, or direct the system to send location [ EEE I ERIEEIEELS
Windows operating

system with either IDE

information (GPS coordinates) back to acentral server.
or AHCI mode enabled,

SATA Mode (Advanced Menu) DO NOT disable the set

Y ou can configure SATA (Serial ATA) control to operate in | DE (native/compati- mbc;detr(llf VO“tWrLShdto -

ble), AHCI (Advanced Host Contrqller Ir?terface) modgs from this menu. The Svi"enee% fg reinc')st:n);ﬁg

SATA Mode should be set BEFORE installing an oper ating system, and after you  BREEENE 6

have backed up all necessary files and data (see sidebar).

Boot Logo (Advanced Menu)

Use this menu item to enable/disable the Boot L ogo screen at system startup. If you
disable the Boot Logo you will not see the F2 Enter Setup or F7 Boot Options
prompts on the screen, however you can still press these keys, while the boot screen
is displayed, to perform the Enter Setup or Boot Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your

machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boot Mode [Standard]

Secure Boot Mode
Standard
Custom

Figure5-4
Security Menu

Set Supervisor Password (Security Menu)

You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility). If you set a supervisor
password you can then add a user password and password on boot.
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Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill ﬁ
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode. You can only set the user password after you JEUNEEEESSEReEE o

. word (Password on boot
have set the supervisor password. s “Enabled”), NEVER

forget your password.

Password Warning

Password on boot (Security Menu) The conseauences of
Specify whether or not a password should be entered to boot the computer (you may  BEEEEEEE bg serious. If
only set a password on boot if a supervisor password is enabled). If “Enabled” you cannot remember
is selected, only users who enter a correct password can boot the system (see the J VAR EIG AT

war ning in the sidebar). The default setting is “ Disabled”. LIS GBI SR Y
dor and you may lose all

. . . of the information on
Note: Toclear existing passwor dspress Enter and type the existing password, then  BEEREEERTES

press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.
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Secure Boot (Security Menu)

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot is available as a menu option if you have
Windows 8 set as your operating system, and have enabled UEFI Boot (see “ Boot
Menu” on page 5 - 16). Enabling Secure Boot will bring up the Secure Boot M ode
menu to enable you to configure Secure Boot as Standar d (with afixed secure boot
policy), or Custom (which enables you to make changes to the | mage Execution
Policy and Key Management database).
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TPM Configuration (Security Menu)

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configur ation and press En-
ter to accessthe sub-menu. Press Enter to accessthe Security Device Support menu
and select Enable to display the full TPM configuration menu (see “ Trusted Plat-
form Module” on page 7 - 96 for details).

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Security Device Support [Disable]

Figure5-5
TPM Configuration
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TPM Sate (Security Menu > TPM Support Enabled)
Select TPM State, press Enter and select Enable to change the TPM state to en-
abled. You will then need to press F4 to save the changes and restart the computer.

Aptio Setup Dtility - Copyright (C) 2012 American Megatrends Inc.

Flgure 5 - 6 Security Device Support [Enable]
TPM State (Enabled)

Asthe computer restarts press F2 to enter the BIOS again and go to the TPM Con-
figuration menu.
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Pending TPM operation (Security Menu > TPM Support & TPM Sate Enabled)
Select Pending oper ation, press Enter and select the option you require (if you are
initializing TPM you should select Enable Take Owner ship). You will then need
to press F4 to save the changes and restart the computer.

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure5-7 5
Pending Operation

(Enable Take

Ownership)

Pending operation [Hone]

Pending operation
None
Enable Take Ownership
Disable Take Owmership
TPM Clear
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Boot Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure5-8

Boot Menu Boot Option #1 [P2: TSSTcorp CDDVDW. .. ]

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
SER R B EEEUEE  \When you turn the computer on it will look for an operating system (e.g. Windows
S EEEEEEEY  7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the

your computer's actual
screens may appear Tk - : L . i !
slightly different from order specified in the Boot Option Priorities. Item specific help on the right is

those pictured on these available to help you move devices up and down the order. Press Enter to select the
pages. Boot Option # device menu, use the arrow keys to select a device, and press Enter
again to confirm the selection.

. |
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Boot Option Priorities (Boot Menu)

Usethearrow keysto move up and down the menu, and press Enter to select adevice
from the Boot Option #list. You can go to either CD/DVD ROM DrivePriorities,
Hard Drive BBS Priorities or Network Device BBS Priorities and use the + and
- keys to move the device' s boot priority up and down the list (the selected device
will be highlighted in white).

OS Sect (Boot Menu)
This item tells allows you to set the operating system you intend to use. This item
should be set before you install an operating system.

UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware I nter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack item will be enabled as an option un-
der UEFI Boot.

|
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Exit Menu

Aptioc Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure5-9
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to itsoriginal state, and erase any previous changes you have madein
aprevious session.

. |
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Upgrading The Computer

Chapter 6: Upgrading The Computer

Overview N

This chapter contains information on upgrading the computer. Follow the steps out- “ '

lined to make the desired upgrades. If you have any trouble or problemsyou can con- Warranty Warning

tact your service representative for further help. Before you begin you will need: Please check with your
- . i tati

* A small crosshead or Phillips screwdriver Zee?é'rcee un;eeﬁ;:i;r;a;x)e,

* A small regular slotted (flathead) screwdriver upgrade procedures to

* An antistatic wrist strap find out if this will VOID

your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

* Removing the Component Bay Cover

» Upgrading the Hard Disk Drive

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make surethat you review each procedure beforeyou perform it.

Overview 6 - 1



Upgrading The Computer

Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

6 - 2 Overview

When Not to Upgrade
These procedures involve opening the system’ s case, adding and sometimes replac-
ing parts.

Y ou should not perform any of these upgradesif:

* Your system is still under warranty or a service contract
* Youdon't have al the necessary equipment

* You'renot in the correct environment

* You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

2N
Ik

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with afast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.



Upgrading The Computer

Removing the Battery -~
If you are confident in undertaking upgrade procedures yourself, for safety reasons o
it is best to remove the battery.

Turn the computer off, and turn it over.

Slide the latch 9 in the direction of the arrow. )

Slide the latch @ in the direction of the arrow, and hold it in place. before undertaking any

Slide the battery out in the direction of the arrow @ upgrade procedures to
) find out if this will VOID

your warranty.
(2] o

Warranty Warning

Please check with your
service representative

PonE

Figure6-1
Battery Removal

Removing the Battery 6 - 3



Upgrading The Computer
Removing the Component Bay Cover

\ A/
PN .
_ 1. Turn off the computer, and turn it over and remove the battery (see page 6 - 3).
Warranty Warning 2. Locate the component bay cover and remove screws @ - @.
3. Carefully remove the cover.

Please check with your
service representative

before undertaking any
upgrade procedures to 9 o
find out if this will VOID

your warranty.

Figure6- 2
Component Bay 9
Cover Removal

.|
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Inserting the Component Bay Cover
1. Replace the bay cover by aligning the cover pins (see sidebar). /

Cover Pins

Note that this computer
model has four cover
pins. These pins need to

be aligned with slots in
the case to insure a
proper cover fit, before
screwing down the bay
cover.

Figure6- 3
Component Bay
Cover Pins

.|
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Upgrading the Hard Disk Drive

The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see“ Storage” on page D - 3). Follow your
operating system’ sinstallation instructions, and install al necessary driversand util-

NP CLEUIEEER  ties (see “ Driver Ingtallation” on page 4 - 2), when setting up anew hard disk.
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.

You have all the discs re-
quired to install your oper-
ating system and
programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

HDD System
Warning

.|
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Removing the Hard Disk

Turn off the computer, and turn it over and remove the battery (see page 6 - 3).

1.

2.
3.
4

Remove the screws @ & @.
Lift the hard disk bay cover up from point 9
Remove hard disk bay cover @.

Upgrading The Computer

Figure6- 4
Hard Disk Bay
Cover Removal

Upgrading the Hard Disk Drive 6 - 7



Upgrading The Computer
5. Slide the HDD assembly in the direction of arrow @.

6. Remove the HDD assembly @.
7. Remove the screw(s) @ - @ and the adhesive cover @.

(5]

Figure6-5

Hard Disk Removal

8. Reverse the process to install a new hard disk drive.
9. Replace the hard disk bay cover and screws.

6 - 8 Upgrading the Hard Disk Drive



Upgrading The Computer

Upgrading the Optical (CD/DVD) Device

1. Turn off the computer, and turn it over and remove the battery and component
cover (see page 6 - 3and 6 - 4).

2.  Remove the screw at point 0 and use a screwdriver to carefully push out the
optical device at point @.

3. Reverse the process to install any new optical device.

Figure6- 6
0 Removing the CD/
DVD Device

Upgrading the Optical (CD/DVD) Device 6 - 9
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-

DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page D - 3 for

details of supported module types).

1. Turn off the computer, and turn it over and remove the battery and component
cover (see page 6 - 3and 6 - 4).

2. The memory (RAM) slots will be visible at point @.

Figure6-7
Memory (RAM)
Location o

.|
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3. Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows (@ & @) in Figure 6 - 8.

(2] Figure6- 8
RAM Module
Release Latches

SN
L&

Contact Warning

9 Be careful not to touch

4. The RAM module will @ pop-up, and you can remove it. the metal pins on the
module’s  connecting

edge. Even the clean-

est hands have oils

which can attract parti-

Single Memory Module cles, and degrade the
Installation module’s perfor-

e mance.

If your computer has a single memory
module, then insert the module into the
Channel 0 (JDIMM1) socket. In this .
case this is the lower memory socket Figure6-9
(the socket closest to the mainboard). RAM Module
Removal

Upgrading the System Memory (RAM) 6 - 11
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o

Pull the latches to release the second module if necessary.

6. Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.

7. The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.

8. Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.

9. Replace the component bay cover and screws.

10. Restart the computer to allow the BIOS to register the new memory configuration

as it starts up.

.|
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Chapter 7: Modules & Options %

Y/

\

1 Wireless Device
OverVI ew Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please  BiiE i 0 o el
contact your service representative. electronic transmission de-

vices aboard aircraft is usu-
» PC CameraModule  Intel Rapid Storage Technology S:Iy Pfogikl)ited- MangSFUf?f
* WirelessLAN Module * Intel® vPro™ Technology ot ate Lsing the comaer
» Fingerprint Reader Module » Trusted Platform Module aboard aircraft.
» 3G Module e Intel® Smart Connect Technology

* Bluetooth & WLAN Combo Module Intel® Wireless Display Application

4

Driver Installation &

For information on the Windows 8 operating system see Appendix F.
Module Power

Make sure any modules
(e.g. WLAN, PC Camera,
3G & Bluetooth modules)
are ON before installing the
appropriate driver.

. |
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7 - 2 Overview

\ A/
L&
Important Notice
If your purchase option includes both Wireless LAN and 3G modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance

requirements, the antenna must not be co-located or operate in conjunction with any other
antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.
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PC Camera Module

A%
Before installing the PC Camera driver, make sure that the optional PC Cameraiis AN
on. Use the Fn + F10 key combination (see “Function/Hot Key Indicators’ on Latest PC Camera
page 1 - 10) or Control Center button to toggle power to the PC Camera mod- RUE Rl
ule. Make sureyouinstall thedriversinthe order indicated in Table 4 - 1, on page 4 B @i G B E-0pliE
- 3. ers & Utilities + User’s
B . ., . . . Manual disc, and any
See“ PC Camera (Windows 8)" on page F - 25 for Windows 8 configuration infor-  BENEEaER I oec
mation. pages, for the latest up-
o o ) dated information on the
When the PC Cameraisin use the LED indicator to the left of the camera will be Bz T EEN  E S

illuminated in red (see @ Figure 1 - 2 on page 1 - 6). which may override the
information provided

here.

There are anumber of different cameramodul es avail able with this computer model
series. You will have the appropriate application installed for your camera. Make PC Camera Driver
sureyou access the application via the desktop shortcut. Uninstallation

a7 If you need to uninstall
’Q‘ the driver, then uninstall
the WebCam Installer
item from the Programs
If the computer enters Sleep or Hibernate mode while running the camera application, the and Features control

PC Camera Application and Power-Saving States

program will stop running, and will need to be restarted when the system resumes from the panel in Windows.
power-saving state.

PC Camera Module 7 - 3
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PC Camera Driver Installation

7\£l'< 1. Make sure the module is powered on, and then insert the Device Drivers &
PC Camera Screen Utilities + User’'s Manual disc into the CD/DVD drive.
Refresh 2. Click Option Drivers (button).
3. Click 1.Install Webcam Driver > Yes.
4. Click Finish to restart the computer.

The PC Camera module
supports a frame rate of

12 fps. If you find that OR

the screen refresh rate Click Next > Finish.

SEEERCREC TS 5. Run the camera application program from the desktop shortcut (if the hard-

tering, then reduce the ware is turned off use the Fn + F10 key combination to turn it on again).

mg‘%ou"tv =lras,; OfF GRS See“PC Camera (Windows 8)" on page E - 25 for information on the cam-
put Size and/or . .

Color Space Compres- era application used in Windows 8.

sion.

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate  pull-down
menu.

7 - 4 PC Camera Module
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Sound (Hardware and Sound).

3. Click Recording (tab).

4. Right-click Microphone and make sure the item is not disabled.

5. Double-click Microphone (or select Properties from the right-click menu).

6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.

7. Click OK and close the control panels.

8. Run the camera application program from the desktop shortcut.

9. Go to the Devices menu heading and select Microphone (VIA....) (it should have
a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

. |
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Figure7-1
Audio Setup for PC
Camera

Right-click

7 - 6 PC Camera Module
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Camera Application
The cameraapplicationisavideo viewer for general purpose video viewing and test-
ing, and for capturing video filesto .avi format.

1. Runthe camera application from the desktop shortcut (it is recommended that you
set the capture file before the capture process - see Set Capture File below).

2. Gotothe Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page 7 - 4) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and |ocation before capture (thiswill help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
“Capturefilesize:” and click OK. Y ou can then start the capture process as above.

Note the important information in “ Reducing Video File Size” on page 7 - 8 in or-
der to save file space, and help prevent system problems.

. |
PC Camera Module 7 - 7



Modules & Options

Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires aminimum of 15GB of free space on the C:
drive system partition. In order to prevent system problems it is recommended that
you save the captured video file to alocation other than the C: drive (see“ Set Cap-
ture File” on page 7 - 7), limit the file size of the captured video or reduce video
resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

4. Click OK.

. |
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Goto Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under PowerLine Frequency.

4

Camera Options

The video capture filter
figure pictured here may
appear slightly different
for some camera mod-
ules. To adjust the anti
flicker properties look un-
der the headings Anti
Flicker/Frequency/Pow-

Q erLine Frequency.

PC Camera Module 7 - 9

Modules & Options

\ /

2 &
Latest PC Camera
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert

pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured.

Figure7-2
Video Capture Filter
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Taking Still Pictures
L& The camera application allows you to take still pictures.

Snapshot Folder 1. Run the camera application from the desktop shortcut.

2. Go to Options and select Take Picture.

3. The picture (in JPEG format) will be placed in the Snapshot folder on the
desktop.

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you

try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

. |
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Wireless LAN Module S

A
If you haveincluded an Intel® or 3rd Party WirelessLAN (or WLAN & Bluetooth _ /Q\ _

. . . Wireless Device
combo) module in your purchase option, make sure that the WLAN moduleison be- Operation Aboard
foreinstalling the driver. See” Wireless LAN Settings (Windows 8)” on page F - 30 A
for Windows 8 configuration information.

The use of any portable

_ . | ; on de.
Usethe WL AN switch totoggle power tothe WirelessL AN module (or usetheFn i,iggrzg'gaiﬁz,sr?:j;';”usﬁ

+ F11 key combination or Control Center button - see” Function/Hot Key Indica- J el E VEICEE

tors’ on pagel - 10). Make sure you install the drivers in the order indicated in [ MEEEECREERCIEal
you are using the computer

Table4 -1, on page4 - 3. aboard aircraft.

: ; Use the Fn + F11 key com-
Note that you need to install both the WLAN & Bluetooth drivers for the WLAN  BEsssia St

& Bluetooth Combo modules. to toggle power to the
WLAN module, and check
the indicator to see if the
module is powered on or
not (see

/

).

Wireless LAN Module 7 - 11
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Figure7-3
Front View

1. WLAN Switch

WLAN Switch

Note that the WLAN
Switch toggles power to
the WLAN module only,

and will not affect the
power status of the
Bluetooth (including the
Bluetooth component of
combo modules) or 3G
modules.

Wireless LAN Switch

The Wireless LAN switch allows you to quickly and easily toggle power to the
WLAN module when necessary.

You can aso use the Fn + F11 key combination (see page 1 - 10) or the Windows
Mobility Center (see page 7 - 33) button to toggle power to the WLAN module,
however these are overridden by the WLAN switch. Check the LED indicator for
the WLAN power status and note the following:

e When the computer boots up, the default WLAN module's power setting
will be according to the WL AN switch position e.g. if the computer starts up
with the WLAN switch in the “ON” position, then the WLAN module will be
on.

» |If thecomputer entersa power saving state, then default WLAN modul€e's
power setting upon resuming will be according to the WL AN switch posi-
tion (even if you have used the Fn + F11 key combination or the Windows
M obility Center button to power off the WLAN module prior to the computer
entering the power saving state) e.g. if the computer resumes from a power sav-
ing state with the WLAN switch in the “ON” position, then the WLAN module
will be on.
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3rd Party 802.11b/g/n Driver Installation (for WLAN Module)
If you see the message “Found New Hardwar €’ click Cancel to close the window.

1. Makesurethemoduleispowered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Choose the language you prefer and click Next.

Click Next.

Click Finish to restart the computer.

oOuhkwN

3rd Party 802.11b/g/n Driver Installation (for Combo Modules)
If you see the message “Found New Hardwar €’ click Cancel to close the window.

1. Makesurethemoduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next.

Click Finish to restart the computer.

LD

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see page 7 - 19). See “ Wireless LAN Settings (Windows 8)” on page F - 30
for Windows 8 configuration information.
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Intel® WLAN Driver Installation

The WLAN driver installation procedure for Intel WLAN modules will depend on
the Intel WLAN module version installed. There are two Intel WLAN driver ver-
sionsavailable, and if you click the 2.Install WL AN Driver buttonin Option Driv-
er s the appropriate driver will beinstalled for you.

» Driver version 1 usesthe Windows OS for Wireless LAN control (see “ Con-
necting to a Wireless Network in Windows 7” on page 7 - 19).

* Theinstalation procedure for driver version 2 will depend on whether or not
you wish to use I ntel® PROSet/Wireless WiFi Connection Utility asyour
WLAN interface, and/or add I ntel® MyWifi Technology (Personal Area Net-
work).

For a standard Intel® WLAN driver 2 installation and configuration choose the
Typical Installation (see “ Typical Installation:” on page 7 - 16 and use the
Windows OS for Wireless LAN control).

If you want to use | ntel® PROSet/Wireless WiFi Connection Utility as your
WLAN interface, and/or add I ntel® MyWifi Technology (Personal Area Net-
work) see Custom I nstallation (for Intel® ProSet and/or Intel® MyWiFi
Technology):” on page 7 - 17.

. |
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Intel® WLAN Driver Installation (Driver Version 1)
If you see the message “Found New Hardwar €’ click Cancel to close the window.

1. Makesurethemoduleispowered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next.

Click the button to accept the license and click Next.

Click Next > Next > Finish.

oOuhkwN

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see “ Connecting to a Wireless Network in Windows 77 on page 7 - 19). See
“WirelessLAN Settings (Windows 8)” on page F - 30 for Windows 8 configuration
information.

. |
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Intel® WLAN Driver Installation (Driver Version 2)

Typical Installation:

1

2.

0N UAW

If you see the message “Found New Hardware” click Cancel to close the
window.

Make surethe moduleis powered on, and then insert the Device Drivers
& Utilities + User’'s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Typical > Install.

Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows after atypical installation (see “ Connecting to a Wireless Network in Win-
dows 7" on page 7 - 19). See“Wireless LAN Settings (Windows 8)” on page F - 30
for Windows 8 configuration information.

. |
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Intel® WLAN Driver Installation (Driver Version 2)

Custom Installation (for Intel® ProSet and/or Intel® MyWiFi Technology):

Note that if you wish to install Intel® MyWiFi you will need to install Micro-
soft.net Framework 4.0 (or later version) beforeinstalling the driver as per the
procedure below. To get the Microsoft.net Framework file go to the Microsoft
website, search for the file, Download it and then install it.

1. If you see the message “Found New Hardware” click Cancel to close the
window.

2. Makesurethemoduleispowered on, and then insert the Device Drivers

& Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next > Custom.

To install Intel® MyWiFi Technology click theicon |=a | alongside I ntel®

MyWiFi Dashboard and select “ Entire feature will beinstalled on local

hard drive” (seeFigure7 - 4 on page 7 - 18).

8. Toinstal Intel® PROSet/Wireless WiFi Connection Utility click theicon
|=2~| aongside it and select “ Entire feature will be installed on local hard
drive” (seeFigure7 -4 on page7 - 18).

9. Click Next > Install > Finish.

10. See* (For Intel® WLAN modules using driver version 2 only)” on page 7
- 22 or “Intel® My WiFi Configuration” on page 7 - 24 for information.

Noo,rw

. |
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Figure7- 4 >

Install Intel® MyWiFi
Technology & Intel®

PROSet/Wireless
7 WiFi Connection
Utility

S
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Connecting to a Wireless Network in Windows 7
Make sure the Wireless LAN module is turned on. 4

1. Click the taskbar notification area wireless icon IFSIEl, and then double-click an Network and
access point to connect to or click to Open Network and Sharing Center if you do Sharing Center
not see a network you want to connect to in the taskbar menu (a list of options will

appear allowing setting changes, and creating a new network). oL el el U e e

work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure7-5
Click Taskbar Icon
Menu & Network
and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying
to connect.

3. Click to select a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.

Figure7-6
Network Location
Set

7 - 20 Wireless LAN Module
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5. Click the taskbar icon 4| to see any currently connected networks.
. . . . . \ L/
6. To disconnect from the wireless network you can click the taskbar wireless icon ﬂ:

., click the active connection and then click Disconnect (button). Security Enabled

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unauthor-
ized access to your
computer, documents, web-
sites and files etc.

Figure7-7
Click Taskbar Icon
Menu - Disconnect
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Connecting to a Wireless Network Using Intel® PROSet Wireless

(For Intel® WLAN modules using driver version 2 only)

1. Make sure the Wireless LAN module is on.

2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All
Programs > Intel PROSet Wireless > WiFi Connection Utility).

3. Click to select a network from the found list WiFi network access points, or click
Refresh to update the list.

Figure7-8
Intel® PROSet/
Wireless WiFi

Connection Utility
(Connect)
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4. Click Connect to connect to the select WiFi network access point.

5. If the access point is encrypted then you will need to enter the password and click
OK.

Figure7-9
Intel® PROSet/
Wireless WiFi

Connection Utility
(Connecting &
Connected)

o

You can turn WiFi On/WiFi Off from the button at the bottom of the Utility.
To disconnect, select the connected access point and click Disconnect.

8. Select Help from the menu at the top of the utility (or at the bottom right) to bring
up the Help menu.

~
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Intel® My WiFi Configuration

a (For Intel® WLAN modules using driver version 2 only)
Intel® My WiFi Help Intel® My WiFi Technology (Intel® MWT) uses your WLAN to transform your
system into a Wi-Fi Personal Area Network, and enables you wirelessly share your
To get help on Intel® & videos, photos, music with other WiFi enabled devices, while still connecting to the

My WIiFi configuration § |nternet through your WiFi wireless connection.
and settings, access the

Intel® My WiFi Dash- . . .
board from the Start Intel® MWT also features achat function, and offers you the option of being able to
menu (Start > All Pro- & create a WiFi hotspot from your computer. Intel® MWT offers greater range and

grams > Intel PROSet | gneed than other personal area networks, and does not require an access point.
Wireless > Intel(R) My

WiFi Dashboard), or by
clicking the taskbar
icon#. click the Help
icon in the dash-
board and select a help
topic from the Contents
menu.
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Intel® My WiFi Configuration
Y ou can configure the My WiFi settings as follows.

1. Make sure the Wireless LAN module is on.

2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All
Programs > Intel PROSet Wireless > Intel(R) My WiFi Dashboard), or click the
icon & in the notification area of the taskbar (or right-click and select Open
Dashboard).

3. Aninitial welcome message will appear on the first run of the program (click “Don’t
show this message again” to turn this off in future).

Figure7 - 10
Intel® My WiFi
Utility - Welcome

. |
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Intel® My WiFi Interface

Figure7-11
Intel® My WiFi

Utility - Interface
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Intel® My WiFi Help
Click theHelp icon  in the dashboard to bring up the Help menu and select and
item from the Contents menu to obtain the help information.

Figure7 - 12
Intel® My WiFi

Utility - Help
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Preferences
Click the Optionsicon [=] and select Prefer ences to configure the options.

Figure7- 13
Intel® My WiFi
Utility - Preferences
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Hotspot
Y ou can turn the computer into a hotspot to allow other devicesto connect to it (and
any locally connected devices), and also (if available) the internet.

1. Click the Hotspot icon to turn the Hotspot on.

2. The Hotspot settings tab shows the SSID and password (you will need to enter
this information when accessing the hotspot from the client computer/device).

3. Click OK to close the Hotspot settings.

Figure7- 14

Intel® My WiFi
O Utility - Hotspot

. |
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Finding Devices

You can find any Nearby Devices by clicking the Refresh button in the main
window. Click again at any time to update the list. If alot of devices are found they
will be listed on multiple pagesand you can usetheleft  orright  buttonstoturn
the pages.

Sensitivity

The Sensitivity controls displays available devices based on their signal strength

and proximity e.g decreasing (-) the sensitivity lists only devices closest to the com-
puter’s location.

Group Devicesby Type

If you click Group by typeit will list all devices according to their type in afolder
group. Double-click on any group folder to see the devices of that type listed. There
are 12 possible device types available.

Search
If you want to search for a particular device by name then enter the device namein
the Search field to return results for devices matching the name of the device.
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Favorite Devices
The Favorite Devicestab is where you keep devices to which you connect most of -
ten, and this is particularly useful in environments where many devices are listed

nearby. A favorite device will display theicon

To make any device afavorite just click to select it and select Add Favorite.

Figure7 - 15
Intel® My WiFi
Utility - Interface

. |
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Connect to a Device

Click the device you want to connect to, and click the connect icon

An invitation will be sent to the target device.

The user must then accept the invitation.

After the invitation is accepted the connection will be made.

Use the Windows Network and Sharing Center to set permissions for viewing
and sharing the resources on your computer with another connected computer.

aogrNPE

Further Information

For information on how to block/unblock devices, setting Do Not Disturb, sharing
an internet connection and chat options see “ Intel® My WiFi Help” on page 7 -
27.
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Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control
Panel).

2. Double-click Windows Mobility Center (Mobile PC).

3. Click the button to Turn wireless off/on, or click the icon il to access the network
menu.

Figure7 - 16
Windows Mobility
Center
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Security Modules (Fingerprint & TPM)

\ A/

’Zl\ The encrypted channel between the Trusted Platform Module security chip (see
Password Warning “Intel® Management and Security Status’ on page 7 - 80) and the fingerprint
el ok oo reader with AuthenTec TrueSuite software (see “ Fingerprint Reader Module®
Sl on page 7 - 35) provides a high level of security for your computer. A further level

SNSRI EREIEE  of security and control is provided in the BIOS (see “ Security Menu” on page5 -
password. 10) )

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

The fingerprint reader with the Protector Suite software allows you to:

Access or Lock your computer

Protect sensitive files

Access frequently used websites using your fingerprint
Fill in frequently log on information

.|
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The fingerprint reader module provides a high level of security for your computer.
Make sure you have administrator’ s rights to your computer, and have a Windows
password enabled for full security protection.

Fingerprint Reader Driver Installation
Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

1

ONOOA~WN

DVD drive.

Click Option Drivers.

Click 3.Install Fingerprint Driver > Yes.

Click Next.

Click the button to accept the license and click Next.
Click Next > Install.

Click Finish > Yesto restart the computer.

Click Sart > All Programs > AuthenTec TrueSuite.

Modules & Options
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™ AuthenTec TrueSuite Application

7Q< The AuthenTec TrueSuite application is used in conjunction with your fingerprint
Fingerprint reader to enroll fingerprints and manage settings etc.
Enrollment

User Enrollment
Note that it is strongly rec- 1. Click Start > All Programs > AuthenTec TrueSuite > AuthenTec TrueSuite.
ommended that you enroll 2. Click Yes when you have identified your fingerprint sensor (@) Fingerprint
more than one finger in : .
case of injury etc. Reader Module in Figure 1 - 2 on page 1 - 6).
3. Click Yes when you are ready to enroll your fingerprints.
4. Click on the fingerprint diagram to select any finger to enroll.
5. You will be required to enter your Windows password (you will be prompted to
create a password if you have not already done so) at this point (click OK to

confirm the password entry).
Figure7 - 17 6. Swipe the finger until the progress bar reaches 100% to enroll that finger.
Fingerprint
Enroliment
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7. You will be prompted to select another finger for enrollment (it is recommended

that you enroll a number of fingers - see sidebar). 4
8. Click the button to continue once you have enrolled a number of fingerprints.
9. Enter the required information and click the button to register your software, or Help
click to register later. . :
. . . . . . Click the Help @ icon
10. Your fingerprints will now be enrolled (you may enroll any additional fingerprints at and select a help topic

any time). from the drop-down
menu. Get more help will
provide a more compre-

hensive list of help topics.

Figure7- 18
AuthenTec
TrueSuite

.|
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Settings

Click the Settings i1 button on the menu bar to access the personalization settings
for AuthenTec TrueSuite. Here you can choose to enable/disable Website Log On,
QuickLaunch, Fast User Switching and the desktop icon. You can also select the
Theme and export/import identities. Click the Save button to save any changes
made.

Figure7- 19
7 AuthenTec

TrueSuite - Settings
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Windows Log On

Windows log on allows you to gain access to your computer by swiping your finger
acrossthe fingerprint reader sensor. Use the Biometric Devices control panel (in the
Hardware & Sound category) in Windows to turn Biometrics on/off when re-
quired. Access the Biometric Devices control panel and select Change biometric
settingsto turn the biometrics on or off, or to allow usersto log on to Windows using
fingerprints.

Figure7 - 20
Biometric Devices
Control Panel
(Windows Hardware
& Sound)

When Biometricsison, and “Allow usersto log on to Windows using their finger-
prints’ is enabled, simple swipe you finger across the reader to log on to Windows.
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Website Log On

Use afingerprint swipeto log on to websites to help you avoid having to remember
user names and passwords across multiple websites (browsers supported are I nternet
Explorer, Firefox and Chrome).

Registering a Website

1. Use your web browser to navigate to the website required.

2. Enter your user name and password and sign in to the website.
3. An AuthenTec TrueStudio dialog box will pop-up.

4. Click Save Password to register the website.

Figure7-21

Save Password

5. The website will now be registered (and your log on and password information will
be bolometrically stored) and you will be prompted to swipe a finger to log on to the

. ebsite in future.
Figure7 - 22 Webstie I T

Log On to Website

.|
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QuickLaunch

QuickL aunch allowsyou to drag and drop icons (which represent websites, folders,
applications and/or computer actions) to any enrolled finger and then swipeyour fin-
ger to launch the icons assigned to that finger.

1. Click Start > All Programs > AuthenTec TrueSuite.

2. Click Select Category F=FHE(button) to group icons if required.

3. Drag and drop an icon to an enrolled finger.

4. To launch the website, folder, application and/or action just swipe your finger
across the sensor.

5. If you have entered the log on information for the website then a single swipe will
launch the website(s), load the log on page and log on to your account.

Figure7 - 23
QuickLaunch
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Adding a Website to QuickLaunch

Click Start > All Programs > AuthenTec TrueSuite.

Click the Add Website button on the menu bar and the dialog box will be displayed.
Enter the website URL, name, icon and category as required.

Click Save and an icon will be associated with the selected website.

To delete an icon right-click it and select Delete Icon and it will no longer be
associated with the finger.

agpNE

7 Figure7-24
QuickLaunch

Add Website
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Dock View

Dock View displays the website icons across the bottom of the screen. Each icon
wiL | have an associated web card which displays the website information, user name
and password etc. Thisinformation may be edited or deleted as required.

Figure7-25
Dock View

EditingaWeb Card

1. Click Start > All Programs > AuthenTec TrueSuite.

2. Left-click a web card to bring up the associated information.

3. You can click the reveal/hide password button to see or hide the password.

4. Make any changes required and click Save to confirm the changes.

5. To delete a web card left-click it and click the Delete icon.

6. Click Print to print and web card and the password will be shown in plain text.

7. You can Print all web cards from the menu bar button if required.
Figure7 - 26
QuickLaunch
Add Website

.|
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Exporting and Importing Your ldentity
Y ou can export your identity to backup your information, or to move it to another
computer.

Exporting Your |dentity

Click Start > All Programs > AuthenTec TrueSuite.

Click the Settings button on the menu bar.

Click Export My Identity.

You will be required to enter and confirm a passphrase and click Next.
Browse to a location to Save the file.

Swipe a finger to confirm the export.

oo h~wNPE

Importing Your Identity

Click Start > All Programs > AuthenTec TrueSuite.
Click the Settings button on the menu bar.

Click Import My Identity.

Browse to the location where the file is saved.

Select the file and click Open.

Type your passphrase and click Next.

The information will then be imported.

Noohs~wNPE

.|
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AuthenTec KeepSafe

The KeepSafe folder is an encrypted area assigned on your hard drive that allows
you to store files and folders to be protected by fingerprint protection. The folder
will appear on your desktop (if selected in the Per sonalization Settings) and in My
Compuiter, but will not be visible to other users of your computer.

To lock/unlock the K eepSafe folder right-click it to display the context menu and
select Unlock/L ock. Y ou will be required to authenticate when unlocking the folder
using either afingerprint swipe or Windows password.

To add filesto KeepSafe folder just open the folder and drag and drop filesinto the
folder. Y ou may also right-click any fileto bring up the context menu and select Add
to KeepSafe (you can select whether or not to keep or delete the original file).

.|
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3G Module

If you have included an optional UMTS/HSPDA OR UMTS/HSPDA+ based 3G
Module (Universal Mobile Telecommunications System or High Speed Packet Ac-
cess) module (see” Communication for All Models” on page D - 4 for specification
details) in your purchase option, you will have the appropriate application (Air Card
Watcher or MobilePartner) provided for Windows 7 (see“ 3G Settings (Windows
8)” on page F - 42 for information on Windows 8 as no driver/application installa-
tionisrequired). Install the USIM card (supplied by your service provider - see page
7 - 48), and then install the application (see over for further details).

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the

Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.
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Beforeinstalling theapplication, make surethat the 3G moduleisON (installing
the driver with the module off will not allow the software to detect the module hard- 4
ware correctly). Usethe Fn +  key combination (see “ Function/Hot Key I ndi-
cators’ on pagel - 10) or Control Center button to toggle power to the 3G
module. Make sure you install the drivers in the order indicated in Table4 - 1, on

page 4 - 3. Note that exiting the application does NOT turn off the 3G module. Note that the 3G modules
DO NOT support system
wake up on 3G modem
activity.

3G Modules &
System Wake Up

* AirCard Watcher - See“ Sierra Wireless AirCard Watcher Installation” on
page 7 - 49 for driver installation information and “ AirCard Watcher Applica-
tion” on page 7 - 50 for instructions on using Air Card Watcher.

* MobilePartner - See “Mobile Partner Application I nstallation” on page 7 -
63 for driver installation information and “ Mobile Partner Application” on
page 7 - 64 for instructions on using M obile Partner.

» See 3G Settings (Windows 8)” on page E - 42 for Windows 8 configuration
information.
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3G Module USIM Card Installation

\ o/

L& Follow the instructions below to install the USIM card (which will be provided by

Power Safety your service provider).
Warning

Turn the computer off, and turn it over.

Slide the latch @ in the direction of the arrow.

Slide the latch @ in the direction of the arrow, and hold it in place.

turned off the power, and Slide the battery out in the direction of the arrow @.

disconnected all peripher- Insert the USIM card @ as illustrated below until it clicks fully into position, and

als and cables (including replace the battery.
telephone lines).

Before you undertake any
installation procedures,
make sure that you have

aogrLNE

USIM Card Orientation 9 e

Note that the USIM card’s

readable side (with the

gold-colored contacts) e
should face upwards (to-

wards the top of the com-

puter) as illustrated.

Figure7-27
Battery Removal &
USIM Card Insertion
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With the 3G module and USIM card (supplied by your service provider) installed
you may then install the Sierra Wireless Air Card Watcher application. AirCard
Watcher alows you to directly access your internet service from the computer.

Sierra Wireless AirCard Watcher Installation

1

2.

Nouk W

PERO o
PO ¢

. |
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Enable power to the module by pressingthe Fn +  key combination or
Control Center button (give the module about 10 seconds to power on).

If aFound New Hardware window appears, click Cancel (click Cancel for
all Found New Hardware windows that appear).

Insert the Device Drivers & Utilities + User’s Manual disc into your DVD
drive.

Click Option Drivers (button).

Click 5.Install 3G Driver > Yes.

Click Next > Install > Finish > Next > Finish.

The hardware driver installation is now complete so select “ No, | will
restart my computer later” and click Finish (do not restart the computer).
Another window will now pop up to install the AirCard Watcher applica-
tion.

Click Next, click the button to accept the license agreement and click Next.

. Click Finish.
. The Air Card Watcher application will now run, or you can click the desk-

top shortcut or run it from the Sierra Wirelessitem in the Sart menu.

Modules & Options

\ /
2 &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + . key com-
bination to toggle power to
the 3G module, and check
the indicator to see if the
module is powered on or
not (see

/
).
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PIN Number

The PIN number for
your USIM card will be
supplied by your service
provider. You usually
have a limited number of
attempts to enter the
correct PIN number.

If you fail to enter the
PIN number correctly
you will be blocked from
accessing the USIM
card and you will need a
PUK (Personal Un-
blocking Key), supplied
by your service provider,
to unlock it.

Figure7 - 28
AirCard Watcher
(Not connected)

AirCard Watcher Application

The connection information is stored on the USIM card supplied by the service pro-
vider (wherethisis not the case you may need to create aprofile - see” Profiles’ on

page 7 - 56).

1. Power on the 3G module using the Fn + key combination.

2. Access the AirCard Watcher application from the Start menu (Start > All
Programs > Sierra Wireless > AirCard Watcher) or the desktop shortcut

3. Ifyou need to set up a network operator (see page 7 - 55).

4. Click the Connect button (a Profile needs to be selected, and in most

cases this will be pre-configured).
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5. The system will connect to your network.
6. Theicon [[@will turn greenfd (and the upload/download speeds will be indicated). /
7. You can then access the internet, download e-mail etc. as per any internet

connection. AirCard Watcher
Help Topics

To get help on AirCard
Watcher configuration
and settings, click the
Menu icon and select
Help Topics.

Always |

Help Tepics

Figure7-29
AirCard Watcher
(Connected)

3G Module 7 - 51



Modules & Options

8. When connected the uplink/downlink speeds will be indicated.
/ \ 9. You can also click the Speed Graph icon to get a visual display of the uplink/
downlink speeds.
Roaming 10. While connected you can also click the icon [EM in the notification area of the
Notification taskbar to display the Windows 7 Mobile Broadband connection status.

AirCard Watcher will
provide notification

when you connect to a
network other than your
service provider. This
can be turned on/off
from User Options >
General > Warning
Messages.

Figure7 - 30
AirCard Watcher
with Speed Graph
(Connected)
&
Taskbar Menu
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11. To disconnect from the service provider, click the Disconnect button
(note that if you click the close [x] icon at the top right of the screen the application / /
will close however the connection will still be maintained).
12. You can also click the icon n in the notification area of the taskbar to display the Online Help

connection status, click Connected, and then click the Disconnect button.

13. The program will disconnect from the service provider.

14. The module will still be on, and you will need to press the Fn + key combination
to turn it off.

Click the Online Help

icon to access the
Sierra Wireless website
for further help if re-
quired.

Figure7 - 31
AirCard Watcher
Disconnect
&
Taskbar Menu
Disconnect
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Air Card Watcher Menu
4 . Right-click the menu [&] button at the top of the Air Card Watcher screen to bring
up the menu, and click to select any item required.

Airplane Mode

Click on the Airplane
Mode icon to turn the ra-
dio power off (e.g. if you
are aboard an aircraft).
You can turn the radio
on again by clicking the
Turn Radio On button.

Figure7 - 32
AirCard Watcher
Menu

. |
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Selecting a Network Operator/Service Provider

In most cases all your network operator/service provider details will be stored on 4
your USIM card, and will not need to be edited/modified. If you do need to set up a

. . ) i Network Operator
network operator/service provider follow these instructions.

If the network operator
1. Access the AirCard Watcher application from the Start menu (Start > All Pro- is not listed then choose
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut . Generic UTMS.
2. Either click the menu [&] button and select Options, or click the Options button
from the main program window.
Click Firmware.
Click to select a Network Operator from the dropdown menu.
Click OK.

ok w

Figure7- 33
Options - Firmware
(Network Operator)
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Figure7- 34
Options - Profile

Profiles

A profile containsinformation used to establish a data connection, and thisinforma-
tionisusually stored on the USIM card supplied by your service provider. However
you can create, edit or delete profilesif required.

Creating a Profile

1.

2.
3.

Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

Make sure you are not connected to a network.

Either click the menu [=] button and select Connections, or click the Connections
button . from the main program window.

Click Profiles and click the Add new profile button and select Custom.

Add new profile
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5. You will need to complete the fields for Profile name, Username, Password and

Access Point Name (you will need to get the username and password details from /
your service provider).

6. Once you have added the details above you can click the Profiles heading menu Edit or Delete
and click to select the profile from the Selected Profile dropdown menu and then Profiles

click OK to set the profile as the default connection.

7. Select the profile and click Advanced to set the Autolaunch, TCP/IP and DNS
settings (check with your service provider for any specific requirements in these
fields).

Select any existing pro-
files to edit or delete it,
and then click OK to

confirm any changes
made.

You can also change the
default profile from the
dropdown menu and then
click OK to confirm the
changes.

Figure7 - 35
Profile - Advanced
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User Options
Y ou can configure User Options asfollows.

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu [&] button and select Options, or click the Options button
from the main program window.

3. Click on any of the menu headings on the left to access the options that may be
configured (note that not all options will be available to be configured as they may
depend on your USIM card settings).

Figure7 - 36
User Options

. |
7 - 58 3G Module



Modules & Options

* General - Thisitem allows you to set options for Sartup/Shutdown, War ning
M essages, Display and Windows support.

» Messaging - Set options here for SM S settings.

* Network - Configure the network settings from this menu though your fre-
guency band information is usually stored on the USIM card.

* SIM Settings - You can set your SIM Security and PIN # options here.

» Sounds- Thisallows you to set sounds applicable to certain application actions
e.g. when anew SMS arrives.

» Profiles- Create, edit, delete and set the default profile from the items here.

» Data Useage Tracking - You can enable/disable data tracking e.g. for billing
purposes.

» Firmware - If you need to change network operator/service provider you can do
so here.
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Text Messaging Service (SMS)

In addition to standard internet services you may also send and receive SMS text
messages using Air Card Watcher, if your service supports SMS.

SMS Express

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu [&] button and select SMS Express, or click the SMS
Express button n from the main program window.

Figure7 - 37
SMS Utility Open
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Sending a Text Message

1. Access the AirCard Watcher application from the Start menu (Start > All Pro- /
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu =] button and select SMS Express, or click the SMS S ESsEEES

Express button [ from the main program window. Sent messages will be
3. Select File > New Message or click the New button in the toolbar. automatically saved to
4. Type the recipients phone number in the “To:” field (to send to multiple recipients the Sent Items folder.

separate the numbers using a semi-colon or space).
Type the message (160 characters max) in the bottom part of the Message window.
6. Click the Send button or Save the message to send/edit later.

o,

Figure7- 38
Profile - Advanced

Notethat you do not have to connect to the networ k to Send/Receive SM S mes-
sages aslong asthe moduleison.
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Inbox

Any received text messageswill be displayed in the I nbox. The number of total mes-
sages and unread messages will be displayed in the inbox folder title.

M essages

Opening a text message: Click on any message in the Inbox to read it in the
bottom panel of the window.

Replying to a text message: Click on any message in the I nbox and select
Actions > Reply or click the Reply button in the toolbar. Type the reply in the
message field and click Send to send the message (or Save to save it in Drafts).

Forwar ding a text message: Click on any message in the appropriate folder
and select Actions> Forward or click the Forward button in the toolbar. Enter
the recipient’s phone number in the “ To:” field and make any additions/changes
required in the message field and click Send to send the message (or Save to
saveit in Drafts).

Deleting a text message: Click on any message in the appropriate folder and
select Actions > Delete or click the Delete button in the toolbar. Click Yesto
confirm the deletion.
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Mobile Partner

With the 3G module and USIM card (supplied by your service provider) installed L6

you may then install the M obile Partner application to directly access your HSPA Wireless Device

internet service from the computer. Operation Aboard
Aircraft

Mobile Partner Application Installation
The use of any portable

1. Enable power to the module by pressingthe Fn +  key combination or et (et (ol
Control Center button (give the module about 10 seconds to power on). vices aboard aircraft is usu-
2. If aFound New Hardwarewindow appears, click Cancel (click Cancel for  JESSEEHG S

all Found New Hardware windows that appear). you are using the computer

3. Insert the Device Drivers & Utilities + User’s Manual disc into your DVD aboard aircraft.
drive.

. . . h + ki .
4. Click Option Drivers (button). tjif;tioﬁ fo”mg& p?\'NCe?TO
5. Click 5.Install 3G Driver > Yes. the 3.75G/HSPA module,
6. Click Next > Install > Finish > Next. and ihtic" thed'fl‘d"?atm 0
7. Click | Agree (button) to accept the license agreement. e v
8. Click Install > Finish. /
9. Choose the language you prefer and click OK, and then click Next. )-

10. Click I Agree (button) to accept the license agreement.

11. Click Next > Install > Finish.

12. Click Finish to restart the computer.

13. Access the M obile Partner application from the Start menu (Start > Pro-
gramg/All Programs> Mobile Partner), or by double-clicking the M obile
Partner icon on the desktop.

. |
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Mobile Partner Application

a Y ou will need to contact your service provider to obtain the exact details of how ex-

Mobile Partner Help actly to configure the settings on this page.

To get help on Mobile | Profile Management

Partner  configuration 1. Power on the 3G module using the Fn +  key combination.
and settings, click the & 2 Access the Mobile Partner application from the Start menu (Start > Programs/

Help menu and select All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
Online Help or press on the desktop
Fl. 3. If you have not created a profile, click Tools and select Options, and then click
Profile Management.
4. Click New and input the appropriate information for Profile Name, APN
and Authentication etc. as supplied by your service provider.
5. Click Save to save the profile.
Figure7- 39

Profile Management

. |
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Connecting to the Service Provider

1. Power on the 3G module using the Fn +  key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
on the desktop

3. The software will run and you can select the Profile Name from the menu.

4. Click Connect to begin the connection process.
Figure7 - 40
Connect
5. The Mobile Partner application will then display the connection information.
Figure7-41
Network

Connection Prompt

. |
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6. While connected you can also click the icon [EM in the notification area of the
taskbar to display the Windows 7 Mobile Broadband connection status.

Figure7 - 42
Connected
Taskbar
Notification Area
Notification

7. You can then access the internet, download e-mail etc. as per any internet
connection.
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8. While you are connected the indicators in the Mobile Partner window will display
uploading and downloading icons.

9. To disconnect click the Disconnect icon, or right click the notification
area icon and select Disconnect (you can also select the connection in the Mobile
Broadband connection status window, and click Disconnect).

Figure7 - 43

© O Disconnect

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the Fn +  key combination
to turn it off.
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12. If you click the Mobile Partner close icon a message will be displayed asking
you to click OK to confirm the program exit and to terminate the connection.

Figure7 - 44
Exit Prompt

13. Exiting the program terminates the connection, but DOES NOT turn off the 3G
module, and you will need to press the Fn +  key combination to turn off the
module (pay careful attention to this aboard aircraft - see “Wireless Device
Operation Aboard Aircraft” on page 7 - 63).

14. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

 |f the 3G module is on and the computer is Shut Down or Restarted; the mod-
ule will be off when the computer starts up.

» If the 3G moduleis on and the computer enters Sleep or Hiber nate; the module
will be off when the computer resumes from sleep.
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Text Messaging Service

In addition to standard internet services you may also send and receive SMS text
messages using the M obile Partner program, if your service supports SMS.

Reading SMS Messages

1. Anicon =] will blink at the bottom of the Mobile Partner interface to notify you of
any new messages received.

2. Click the Text icon in the Mobile Partner Interface.

3. Select the Local > Inbox or SIM/USIM Card folder and select any message to
read it.

4. Right-click the message and choose an option to reply, forward or delete the
message.

Creating and Sending SMS Messages

1. Click the Text icon in the Mobile Partner Interface.

2. Click the New button [=].

3. Enter the recipient’'s number in the Send To... field or click the Send To... button to
select an entry from the phone book, and click OK.

4. Type in the message details.

5. Click the Send button, Save button to send the message later or Close > Yes to
save in the Draft folder.

For more details on SMS click the Help menu and select Online Help or press F1
and select SM S

. |
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Bluetooth & WLAN Combo Module

e e If your purchase option includes the Combination Wireless LAN & V3.0 Blue-
o pEES e tooth module (either Intel® or 3rd Party) then install the driver asinstructed from
peration Aboard .
e the appropriate page (see below).

2N\L
Z S

The use of any portable Usethe Fn + F12 key combination or Control Center button to toggle power to
electronic transmission de- the Bluetooth module.

vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

4

Bluetooth Data Transfer

you are using the computer
aboard aircraft.

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
Use the Fn + F12 key com-

bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

! » For 3rd party Bluetooth modules see the information provided overleaf.

» For Intel Bluetooth combo modules see the installation procedure see “ I ntel
Bluetooth Combo Driver Installation” on page 7 - 72 and “ Standard Bluetooth
Configuration in Windows 7" on page 7 - 73.

).
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3rd Party Bluetooth (V4.0) Combo Driver Installation

Notethisdriver isrequired for the 3rd Party combo Bluetooth and WLAN module
(Bluetooth V4.0) only.

1. Beforeinstallingthedriver make suretheBluetooth moduleispowered

on (use Fn + F12 key combination), then insert the Device Drivers & Utili-

ties+ User’'s Manual disc into the CD/DVD drive. If aFound New Hard-

ware window appears, click Cancel in all windows that appear, and then

proceed to install the driver as below.

Click Option Drivers (button).

Click 5.Install Combo BT Driver > Yes.

Click Next (if aprompt appearsto ask you to turn the Bluetooth power on,

pressthe Fn + F12 key combination to do so, otherwise the driver will not

be installed).

5. Click Finish to restart the computer.

6. See“Sandard Bluetooth Configuration in Windows 77 on page 7 - 73 for
configuration instructions.

PwN

. |
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4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.

Intel Bluetooth Combo Driver Installation

Notethisdriver isrequired only for the I ntel combo Bluetooth and WLAN module
only.

1

NoakrwN

Beforeinstalling thedriver makesurethe Bluetooth moduleis powered
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties+ User’'s Manual disc into the CD/DVD drive. If aFound New Hard-
ware window appears, click Cancel in all windows that appear, and then
proceed to install the driver as below.

Click Option Drivers (button).

Click 5.Install Combo BT Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Next > Finish.

See over for configuration instructions.
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Standard Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On

1. Pressthe Fn + F12 key combination to power on the Bluetooth module.

2. A Bluetooth icon ] will appear in the notification area.

3. You can then do any of the following to access the Bluetooth Devices control
panel.

« Double-click the natification area icon E to access the Bluetooth Devices control panel.
« Click/Right-click the notification area icon H and choose an option from the menu.

Add a device Right-Click Notification Area Icon [J

Bluetooth & WLAN Combo Module 7 - 73
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4

Add a Device

Click Start, and click Con-
trol Panel and then click
Devices and Printers
(Hardware and Sound).
Click Add a device to
search for any available
Bluetooth devices.

Bluetooth Module &
Resuming From Sleep
Mode

The Bluetooth module’s de-
fault state will be off after
resuming from the Sleep
power-saving state. Use
the key combination (Fn +
F12) to power on the Blue-
tooth module after the com-
puter resumes from Sleep.

Figure7 - 45
Bluetooth Devices &
Click Icon Menu
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To Add a Bluetooth Device

/ 1 1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure7 - 46

Add a Device ] ) ) ) ) B
3. Onfirst connection the computer will provide you with a pairing code to be entered

onto the device.

7 - 74 Bluetooth & WLAN Combo Module



Modules & Options

4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

4

o Figure7 - 47
Pairing Codes

Pairing Code
The example outlined here shows a connection to Example

a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.

7. Click Close.

Figure7 - 48
Pairing Complete &
Bluetooth Device
Enabled
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To Change Settings for the Bluetooth Device
/ 1. Click the notification area icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:
¢ Change the name of the device (click Bluetooth, type a new name and click OK).
To get help on Bluetooth » Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

configuration and set- . .
fings, select Help: and To Make your Computer Discoverable to Bluetooth Devices

Support from the Start 1. Click the notification area icon and select Open Settings.
menu. Type Bluetooth in 2. Click Options, and make sure that Allow Bluetooth devices to find this

Bluetooth Help

the Search Help box, and computer check box (Discovery) has a tick inside it.
select an item from the re- 3. Make sure that the Alert me when a new Bluetooth device wants to connect
turned search results to check box (Connections) has a tick inside it, if you want to be notified when a
get more information. Bluetooth device wants to connect.
Figure7- 49
Bluetooth Settings -
Options
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Intel Rapid Storage Technology

Install the Intel Rapid Storage Technology to support your SATA driveif set up in
AHCI modein the BIOS (see“ SATA Mode (Advanced Menu)” on page5 - 9).

IRST Driver Installation

1.

WD

o

Insert the Device Drivers & Utilities + User’'s Manual disc into the CD/
DVD drive.
Click Option Drivers (button).

Click 6.Install IRST Driver > Yes.
Click (click the button to “Install Intele Control Center”) Next > Yes >

Next > Next.
Click Finish to restart the computer (you will need to restart the system
again after the computer has rebooted).

* TheIntel® Control Center providesacentral starting point for Intel applications
tomakeit easier to find programs required. Accessthe Intel® Control Center from
the Start > All Programs > Intel > Intel® Control Center.
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Intel® vPro™ Technology

Intel® vPro™ Technology is supported by Model B computersonly. This set of
technology features, built into the computer’s motherboard, allows Information
Technology departments remote access to the computer. This allowsthe IT depart-
ment to monitor, maintain and manage computers regardless of the state of the op-
erating system or the computer’s power state. This can be done over a wired or
corporate wireless network, or even outside the corporate firewall through a wired
LAN connection.

Accessing the Intel Management Engine

To accessthe Intel Management Engine press Ctrl + P at startup. Y our system ad-
ministrator will need to assist you in managing the information as applicable to your
enterprise. Note the following password information for the Intel Management En-
gine:

» Thedefault password is“admin” (without quotes).

If yougetan"Error - Intel(R) M E password changer g ected" message when cre-
ating a new password, then note the following parameters for creating a password:

* between 8 and 32 characterslong

» Contain both upper and lower case Latin characters

* Have at least one numeric character

» Have at least one ASCII non-aphanumeric character (!, @, #, $,%, , &, *)
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MAIN MENU

MEBx Login
Figure 7 - 50
Intel(R) Management
Engine

- (Password Creation)
Intel (R) ME Pa

ML = Move Highlight

Select MEBx L ogin and press*“ Enter” to accessthe password screen. Enter the pass-
word “admin” (without quotes) and you will then be prompted to enter your own
password (note the password information on the previous page). Once you have en-
tered the password you will then be taken to the platform configuration screen.

The platform configuration screen allows you to setup Intel ME as per your require-
ments (consult your I T administrator for the actual settings required).

.|
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Intel® Management and Security Status

(Model B Only)

Accessthe Intele M anagement and Security Status control panels from the Start
menu  in Windows. These features allow usersand IT Administrators to enhance
and protect computing assets. Y our system administrator will need to assist you in
managing some of the information here.

User Guide
You can access the user guide provid-
7 ed to get help on any aspect of the In-
Figure 7-51 tel® Management and Security Status
Intel Management & control panel.
Security Status Help Click on Learn More at the bottom left

of the control panel and then click “Eor

more information, refer to the user
aquide” (link).

You will need to have the Adobe Acro-
bat Reader program installed (this is
provided on the Device Drivers & Util-
ities + User’s Manual disc.

-
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General

The General tab provides basic information on Intel® AMT, Intel® Standard Man-
ageability, Level 3 Manageability Upgrade, Intel® Anti-Theft and Intel® RPAT sta
tus and events.

Figure7 - 52
Intel Management &
Security Status
General

.|
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Intel® Active Management Technology
The Intel® AMT tab will be shown if you system is configured to support it. This
allows your network’s I T professionals to remotely discover, heal and protect your

computer.

Figure7 - 53
Intel Management &
Security Status
Intel® AMT

.|
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Intel® Anti-Theft
Thistab displays information on Intel® Anti-Theft information. Click on the link to
connect to an Intel site to get more information on Intel® Anti-Theft technology.

Figure7 - 54

Intel Management &
Security Status
Intel® Anti-Theft
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Advanced
The Advanced tab provides additional information on the system.

Figure7 - 55

Intel Management &
Security Status
Advanced
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Trusted Platform Module

The TPM security chip allowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by asys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’ s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
aremovablemedia (e.g. aUSB flash drive) to stor e passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
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Enabling & Activating TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.

Use the arrow keys to select the Security menu

Select TPM Configuration and press Enter.

Select Security Device Support and press Enter, select Enable and press Enter.
Select TPM State, press Enter and select Enabled to change the TPM state to
enabled. You will then need to press F4 to save the changes and restart the

computer.

oukrwnPE

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Ing.

[Enable]

. Security Device Support

Figure7 - 56
TPM State
(Enabled)

7. As the computer restarts press F2 to enter the BIOS again and go to the TPM
Configuration menu.

. |
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8. Select Pending operation, press Enter and select the option you require (if you
are initializing TPM you should select Enable Take Ownership) and press Enter.
You will then need to press F4 to save the changes and restart the computer.

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure7 - 57
Pending Operation
(Enable Take
Ownership)

Pending operation [Hone]

Pending operation
Hone

Enable Take Owmership
Disable Take Ownership
TPM Clear

9. You can now install the TPM driver (see “Trusted Platform Module (TPM)
Driver Installation” on page 7 - 88) and then initialize the TPM.
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Trusted Platform Module (TPM) Driver Installation

1. Makesureyou haveenabled and activated the TPM in theBIOSbefore
installing thedriver (if you do not do see the note below).

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 7.Install TPM Driver > Yes.

Click Install > Next.

Click the button to accept the license and click Next.

Click Next > Next > Install.

Click Finish > Yesto restart the computer.

N

00N U AW

. |
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Initializing TPM
1. Run the application from the Infineon Security Platform Solution > Manage
Security Platform item in the Start > All Programs menu.
2. Click User Settings (tab) and click Yes, or right-click the icon EE in the notification
area of the taskbar, and select Security Platform Initialization (or click the
Security Platform State taskbar bubble).
3. The Quick Initialization method will automatically be selected for you (if you need
to use advanced settings provided by your network administrator then select
Advanced Initialization).
4. You will need to use a removable media (e.g. a USB Flash Drive) to store
passwords and data (keep the media in a safe place until required).
5. Select the drive you want to use from the drop-down menu and click Next. .
7

Figure7 - 58
Security Platform
Quick Initialization

Wizard
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6. Choose the Security Platform Features you want to use by clicking the
appropriate tickbox.
7. Enter a Basic User Password (and re-type to confirm it) and click Next.
Figure7-59
Settings

4

Help

Right-click the icon in
the notification area of the
taskbar to bring up the menu
to select Help or How to use
the Security Platform Fea-
tures.

&

v 5o dlick the Hel Click Next to confirm the settings.
pon oS the Help £ 9 The computer will then initialize the settings.
utton in any of the Infineon . o
Security Platform Settings || 10. Click Finish. _ _
Tool tabs to bring up specific 11. Click the tabs and control panels to adjust the settings.
help topics on each tab. 12. Double-click the taskbar icon to access the Infineon Security Platform
Settings Tool, or right-click the taskbar icon and select a menu item.
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Infineon Security Platform Settings Tool
The Infineon Security Platform Settings Tool allows you to manage and check the 2
TPM state, manage your password information, and to backup and restore the TPM Menus
data. As TPM is usualy administered within large enterprises and organizations,
.. . . . . - - Note that not all the
your system administrator will need to assist you in managing the information here. | = S e vl

be available for access.
The menu items that ap-
pear will be dependent on
your configuration set-
tings etc. (see the Help
file for full details).

Figure7 - 60
Infineon Security
Platform Settings

Tool

. |
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User Settings

This page allows the settings to be configured for the currently logged in Infineon
Security Platform user including the ability to change the password, configure se-
cure e-mail, file and folder encryption and Enhanced Authentication. Y ou can also
import or delete certificates protected by the security platform.

Figure7 - 61
Infineon Security
Platform Settings

Tool (User Settings)
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Backup

Here you can configure backup and restore operations. Backup files contain the
computer identification and user identification information which is used to match
the machine name and user name with the current machine and user during restora-

tion.

Figure7 - 62
Infineon Security

Platform Settings
Tool (Backup)

. |
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Migration
The Migration tab is used to help securely transfer keys and certificates from one
platform to another.

Figure7 - 63
Infineon Security

Platform Settings
Tool (Migration)
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Password Reset
Use Password Reset to reset basic user passwords when required.

Figure7 - 64
Infineon Security

Platform Settings
Tool 7
(Password Reset)

Trusted Platform Module 7 - 95



Modules & Options

BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk and is done via the Microsoft BitL ocker Control Panel Applet.
Click Configure and select a drive to be encrypted and then follow the Wizard to
begin the encryption process.

Figure7 - 65
Infineon Security

Platform Settings
7 Tool
(BitLocker)
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Access the Microsoft BitL ocker Drive Encryption control panel applet from the
Windows control panel (System and Security).

Figure7 - 66
BitLocker Drive

Encryption
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Advanced
Configure all the Security Platform owner and policy settings from the Advanced
tab. The settings that can be changed are for the local computer only.

Figure7 - 67
Infineon Security

Platform Settings
7 Tool
(Advanced)
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Intel® Smart Connect Technology

Intel® Smart Connect Technology periodically, and briefly, wakes the computer
from Sleep mode in order to update information for certain applications (e.g. to get

Z

Intel® Smart Connect
Technology System

mail from Microsoft Outlook) as required. These updates can therefore be made Requirements
without having to turn the computer on, and applicationswill be up to date when the _

ter resumes from Sleep mode (make sure that I ntel Smart Connect Technol- Note that in order to sup-
ComP“ . eep port Intel® Smart Con-
Menu)” on page5 - 8). system will need to have

the item enabled in the
Note that the applications need to be on and running when the computer enters || BIOS (seepage5-8).
Sleep mode in order to get updates. n addition only the follow-
ing WLAN modules sup-
port this feature:

Intel® Centrino®

Intel® Smart Connect Technology Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD Wireless-N 2230
drive. Intel® Centrino®
2. Click Option Drivers (button). Ir‘]’:’;geésn’t“”ﬁ%
3. Cl!ck 8.Install ISCT Driver > Yes. e BT
4. Click Next. Intel® Centrino®
5. Click the button to accept the license agreement and click Next. Advanced-N 6235
6. Click Next > Install > Finish.
7. Click Yesto restart the computer.

.|
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Intel® Smart Connect Technology Configuration

N\ A/
ﬂ‘ 1. Access the Intel(R) Smart Connect Technology application from the Start menu.
Wireless Device 2. Click Basic (tab) and adjust the slider to set the update frequency (note that the
Operation Aboard slider balances between “More Frequent Updates” and “More Battery Life”).
Aircraft 3. Note the sidebar warning about the use of Intel(R) Smart Connect Technology
aboard aircraft and make sure your wireless LAN module is off during air travel.
The use of any portable 4. In order to update any applications, they will need to be on and running when the

SIECHONIC UIANSMISSION de= computer enters Sleep mode.
vices aboard aircraft is usu-

ally prohibited. Make sure
the module(s) are OFF if

you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Figure7 - 68
iSCT Basic
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o

Click Advanced (tab) to access the Extended Power Savings settings.

6. Extended Power Savings allows you to set a time period during which the
computer will update less often (e.g. at night while you are asleep or whenever you
are at work).

Figure7 - 69
iSCT Advanced

7. Updates set during this time period will be performed every two hours, and this will
override the settings selected in the Basic tab in order to conserve power
consumption.
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8. Click the Help tab and click Topics to access the main Help menu.

4

Intel WLAN Modules

If your purchase option
includes an Intel WLAN
module, (with Intel's
PROSet Wireless Con-
nection  Utility in-
stalled), Intel® Smart Q
Connect Technology
will search for WiFi net-
works around you that

you have previously ac-
cessed.

If no known WIiFi net-
works are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure7-70
iSCT Help
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Intel® Wireless Display Application

The Intel® Wireless Display Application (requires Intel® Centrino WLAN/ /_
Combo module), in conjunction with acompatible video adapter (purchased sep- Compatible
arately), allows you to display the contents of the notebook display on another dis- Adapters

play (e.9. HDTV) without the need to have cables stretching acrossaroom. Youcan | For a list of compatible
then play games, browse the internet, display videos or photo slide shows on your | display and audio adapt-
TV/external display without using HDMI or A/V cables. ers check the Intel web-

site, or your service

ter.
Before configuring the Intel® WiDi application you will need to set up your com- cemet

patible adapter with your display/speakers. Connect the adapter using an HDMI or
A/V cable and turn on the display (or in the case of speakers connect them to the
wireless speaker adapter with the cables provided with the adapter), and then set the
display to the appropriate input channel (see the documentation supplied with your
compatible adapter for full details).

Intel® WiDi also incorporates I ntel® Wireless Music which allows you to wire-
lessly stream audio from your computer to speakers connected to a compatible
wireless speaker adapter (purchased separately).
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Intel® WiDi Application Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 9.Install WiDi AP > Yes.

Click Next.

Click the button to accept the license and click Next.

Click Finish.

Intel® Wireless Music Driver Installation

If you wish to use your system to stream wireless audio to speakers connected to a
compatible wireless speaker adapter you will need to install the Intel(R) Wireless
Music Driver.

oOUkwN

1. Insert the Device Drivers & Utilities+ User’s Manual disc into the DVD

drive.

2. Click Browse and browse to the driver location (X: denotes your DVD
drive):

e X:\Options\02_WLAN\Intel_WMusic\autorun.exe

3. Click Next.

4. Click the button to accept the license and click Next.

5. Click Finish.

6. Follow the procedure overleaf to setup WiDi or Wireless Music.

.|
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Intel® WiDi Application Configuration
1. Click Start > All Programs > Intel Corporation > Intel(R) Wireless Display >
Intel(R) Wireless Display, or double click the icon on the desktop.

2. Click I agree to the terms of this license (button).
3. The application will scan for any connected compatible adapters (or you can click
the Scan for available adapters button to enable Intel My WiFi Technology).

Figure7-71 7
Intel® WiDi Scan
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Click to select and detected adapters, and click Connect.

The system will then prompt you to enter the 4-digit security code which will be
displayed on the external TV Screen (or press the connect button on the wireless
speaker adapter).

6. Enter the code for the video adapter and click Continue.

ok

Figure7- 72
Intel® WiDi Connect
& Enter Security
Code

.|
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7. You will then be prompted to enter a name for the video adapter and click
Continue.
8. Click Finished to complete the setup.

4

Test Audio Adapter

To verify a successful
audio connection (for In-
tel® Wireless Music),
select the “Test your
audio connection” link
or select “Finished” to
bypass the test.

You can select “Play
O O Sample” to play an au-
dio test sample from
your adapter to the con-

nected speaker set.

Figure7- 73
Intel® WiDi
Connected
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Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sure it is actually working. Check the LED Indicators (see“ LED Indicators’ on page 1 - 7) to see
the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
Ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB stor age devicesin any connected drive
(thisis acommon cause of the message “Invalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Supervisor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

2NZ
Z_ S

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

Install an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
gramsto check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

» Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator ,is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using a
USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 11).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 15). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the Touchpad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix C for instructions on installing and configuring
on. the video driver.

. |
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

SN
L&

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 10) to adjust.

Unwelcome numbers appear when
typing.

If the LED Ii'] is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1-7).

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will

detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.

Problems and Possible Solutions 8 - 9




Troubleshooting

Problem

Possible Cause - Solution

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN or Bluetooth modules
cannot be detected.

The modules are off. Check the LED indicator and/or function key indicator to
see if the WLAN/Bluetooth module is on or off (see “LED Indicators” on
page 1 - 7). If the LED indicator is off, then press the Fn + F11 (WLAN)/WLAN
Switch or Fn + F12 (Bluetooth) key combination(s) in order to enable the
modules (see Table 1 - 2, on page 1 - 10).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 10). Run the camera
application to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Camera modules cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).
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resuming from Sleep.

Problem Possible Cause - Solution
A file cannot be copied to/from a | The transfer of data between the computer and a Bluetooth enabled device is
connected Bluetooth device. supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the device to your computer until
the file transfer process from the computer has been completed.
The Bluetooth module is off after | The Bluetooth module’s default state will be off after resuming from the Sleep

power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

| am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

The computer is off (or in Sleep Mode) but
powered by the AC/DC adapter plugged in
to a working outlet, or by battery with a
capacity above 20%. | have plugged a
device into the powered USB port in
order to charge it, but the device is not
charging.

The port is not powered on. Toggle power to the port using the Fn + power
button combination.

This function may not work with certain external USB compliant devices (check
your device's documentation). If this is the case, power the computer on and
connect the external USB device in order to charge it.

Note that this function is designed to help charge USB compliant devices, but
is not designed to allow their operation.
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Problem Possible Cause - Solution

| previously turned off the WLAN module | The computer entered a power saving state with the WLAN Switch in the ON
using the Fn + F11 key combination (or | position, and upon resuming from the power saving state the WLAN module
Windows Mobility Center button), but | turned ON. The position of the WLAN switch governs the power status of the
upon returning to the machine the LED | WLAN module at startup, and upon resuming from a power saving state. This is
indicator shows the WLAN module is ON. | the case even if you have previously turned the module off using the Fn + F11
key combination or Windows Mobility Center button prior to the computer
entering a power saving state.

The USB port, card reader or ExpressCard | The power to the USB port, card reader or ExpressCard has been disabled in
do not appear to be working. the BIOS. Go to the BIOS and enable the item.
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Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows M obile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Micr osoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

Install the Microsoft Windows Device Center Driver as appropriate for your operating system.

Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
Make sure the Bluetooth device is powered on.

Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and
Printers).

5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have
connected, or tried to connect to, a Bluetooth device previously).

PobdNPE

2 Network adapters /
'3 Atheros ARSO0TEG Wireless Network Adapter

l&-"‘ Bluetooth Device (Personal Area Network) . A
Bluetooth Device (RFCOMM Protocol TDI Bluetooth Peripheral Devices

: e* Marvell Yukon 88E8040 PCI-E Fast Ethernet Controller You will need to repeat the procedure
4|5 Other devices

o
[

: : listed here for all Bluetooth Peripher-
/7 Bluetooth Peripheral Device A R q
[ PCIFLASH Memory al Devices listed under Other Devices
» I Processors i.e. until there are no more Bluetooth
»-% Sound, video and game controllers Peripheral Devices listed under this
b - Storage controllers menu heading_

ol Siertarn Asiricar

Figure 8 - 1 - Device Manager
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.

7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...
9. Select Bluetooth Radios from the list.

>

Figure 8 - 3 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for
Microsoft Corporation to appear in the list).

12. Select Windows Mobile-based device support from the Model list.

@ |l Update Driver Software - Bluetooth Peripheral Device

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. I you have a
disk that contains the driver you want to install, click Have Disk.

Manufacturer “ || Maodel

Rl Windows Mobile-b ice support

Make sure you select
Microsoft Corporation

| This driver is digitally signed.

Tell me why driver signing is important
Ciies ]) Gona

Figure 8 - 4 - Select Device Driver
13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth
Radios.
16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

>

Figure 8 - 5 - Device Manager - Bluetooth Radio

. |
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Resolving the “Insert a SIM” issue with the 3G Module (Windows 8)

1. IfaPIN was set for the EM820W 3G module, you have then switched Mobile broadband off (or put the system

in Airplane Mode) under Wireless in PC Settings, and the system has just resumed from a power-saving state
the following error may occur.

PC SettlﬂgS Airplane mode

Turn this on to stop wireless communication

Search off |

Share Wireless devices

Mobile broadband \

off [
Privacy

Devices

Mobile broadband hardware

Huawei Technologies

General

Ease of Access

Figure 8 - 6 - PC Settings (Charms Bar) - Wireless (Mobile Broadband Off)

2. Onresuming from the power-saving state the standard procedure would be to go to PC Settings in the Charms
Bar and turn on Mobile broadband under Wireless > Wireless Devices.
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Go to the Charms Bar.

Select Settings and you will then note that the WiFi icon will read Unavailable.
Standard procedure would be to click the connection and enter the PIN number to unlock the connection.
In this instance you will note that the Mobile broadband connection will read Insert a SIM.

o0k w

(© Networks

Airplane mode

off N

Mobile broadband

Insert a SIM

Figure 8 - 7 - Mobile Broadband (Insert a SIM)
7. In this case you will need to restart the computer.
8. After system restart you can then connect to the Mobile Broadband as normal.
9. To fully resolve this issue it is recommended that you do not Enable a PIN for the EM820W 3G module.
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Notebook Ports and Jacks

Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.
e-SATA Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
e-SATA Attachment) port.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.
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Iltem Description
Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
RJ-45 LAN Jack This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

.|
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Item

Description

USB 2.0/1.1 Port

USB 3.0 Ports

3.0
Powered USB 3.0 Port

3.0

&

The USB 2.0 compatible port (USB 2.0 is fully USB 1.1 compliant) is for low-speed peripherals
such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs,
digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and
unplugged from the computer, without the need to turn the system off (if the power rating of your
USB device is 500mA or above, make sure you use the power supply which comes with the
device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 port is colored black. USB 3.0
will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that the USB 3.0 port requires a driver (see “USB 3.0 (Win 7 Only)” on page 4 - 7) installa-
tion for Windows 7 (Windows 8 does not reqquire a driver) and does not support wake on USB.

*Note: The powered USB 3.0 port (see “System Map: Left View” on page 1 - 13) may be tog-
gled on /off by means of the Fn + Power Button key combination. When the powered USB port is
on it will supply power when the system is off but still powered by the AC/DC adapter plugged into
a working outlet, or powered by the battery with a capacity level above 20% (this may not work with
certain devices - see page 8 - 11).

Note: This function is designed to help charge USB compliant devices, but is not designed to
allow their operation.

A - 4 Interface (Ports & Jacks)




Control Center

Appendix B: Control Center
Overview

Thefollowing chapter will give aquick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center icons to toggle the appropriate function, or hold the mouse button down
and move the dlider where applicable. Certain functions will automatically be adjusted when a power mode is
selected. The Control Center in Windows 8 works under the Desktop app (see “ Desktop Application” on

page F - 4) and not under the Start screen, and does not feature the wireless/Bluetooth buttons and Airplane
Mode etc.

Figure B - 1 - Control Center
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Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the power status of modules (e.g. WLAN, Bluetooth, 3G or Camera), screen brightness,

TouchPad power and Silent Mode.

You can click aControl Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off any modules etc.

Thetableoverleaf illustrates the basic settingsfor each power mode. If you choose user defined the settings
will correspond to your selected system settings.

. |
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. Flight . . User
Modes Power Saving g Entertainment Quiet Performance .
(Win 7 Only) Defined
Icon ” '
£3
Power Plan Power Saver Balanced Power Saving Power Saving High Performance
Power Conservation Mode Energy Star BIOS Default Energy Star Energy Star Performance
Brightness 14 42 100 42 100
WLAN
(Win 7 Only) OFF OFF ON ON ON c
]
Bluetooth g
(Win 7 Only) BIOS Default )
(0]
(=8
3¢ OFF OFF OFF OFF OFF
(Win 7 Only)
PC Camera OFF OFF OFF ON ON
TouchPad E ON ON ON ON ON

Table B - 1- Power Modes
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Power Status

The Power Status icon wiil show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness

The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or usethe Fn+ F2 key combination to turn off the LED backlight
(pressany key to turn it on again). Note that screen brightnessis also effected by the Power M ode selected (see
TableB - 1, on page B - 3).

Volume
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F4 key combination to mute the volume.

Power Conservation

Thissystem supports Ener gy Star power management features that place computers (CPU, hard drive, etc.) into
alow-power sleep modes after a designated period of inactivity (see “ Power Conservation Modes’ on page 3 -
10). Click either the Perfor mance, Balanced or Energy Star button.
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Sleep
Click the Sleep button to bring up the Hiber nate or Sleep buttons, and click either button to have the
computer enter the appropriate power-saving mode (see “ Power-Saving States’ on page 3 - 6).

Display Switch
Click the Display Switch button to access the menu (or use the & + P key combination) and select the appro-
priate attached display mode (see page C - 10).

Time Zone
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background
Clicking the Desktop Background button will alow you to change the desktop background picture.

TouchPad/PC Camera/Wireless LAN Module /Bluetooth/3G Module
Click any of these buttonsto toggle the TouchPad or modul €’ s power status. A crossed out icon will appear over
the top left of theicon when it is off. Note that the power status of a module, and TouchPad power, is also
effected by the Power Mode selected (see Table B - 1, on page B - 3). The WLAN, Bluetooth and 3G buttons
are not featured in the Windows 8 system.

¥ g

Docking Wu

Docking

Click the Docki ng button to prepare the system for docking/undocking.
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Caps Lock/Scroll Lock/ Number Lock & & &
Click the button to toggle the appropriate lock mode.
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Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
page1 - 19.

Video Driver Installation
Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3.

1.

1
2.
3.

Insert the Device Drivers & Utilities+ User’'s Manual disc and click I nstall
Drivers (button).

Click 2.Install VGA Driver > Yes.

Click Next > Yes > Next > Next.

Click Finish to restart the computer.

Note: After installing the video driver go to the Display/Display Settings control
panel to adjust the video settings to the highest resolution.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to 1748M B)
system memory (RAM) as needed to the integrated video system (the video driver
must beinstalled). DVMT returns whatever memory is no longer needed to the op-
erating system.

Video Driver Installation C - 1

4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your service center for
the latest details on vid-
eo cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
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4

Application Mode

Note that all figures pic-
tured, and instructions
outlined here are based
on the Advanced
Mode.

FigureC-1
Intel® G&M
Control Panel

Intel® Graphics & Media Control Panel

Advanced video configuration options are provided by the Intel® Graphics and
Media Control Panel. To access the control panel:

1. Click Advanced settings in the Screen Resolution control panel in Windows.

2. Click the Intel(R)... tab and click Graphics Properties (button).

OR

3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Double-click the Intel(R) G&M control panel in Windows.

5. Choose the application mode (Basic, Advanced or Wizard) required (see sidebar).

>
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Y ou may make changes to any of the graphics properties by clicking the appropriate
menu tab on the left of the menu and adjusting the settings on the right. 4

Options & Support

Click Options & Sup-
port and select an item
from the sub-menu to
bring up the help and
support topics.

You will need to be con-
nected to the Internet to
access the key resource
links.

Multiple Display

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

FigureC- 2

Intel® G&M
Control Panel Tabs

Intel® Graphics & Media Control Panel C - 3
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4

Function Key
Combination

You can use the Fn + F7

key combination to tog-

gle through the display

options:

* Notebook Only

» External Display Only

* Notebook + External
Display

Make sure you give the

displays enough time to
refresh.

Note that HDMI sup-
ports video and audio
signals.

TableC-1
Display Modes

Display Devices & Options

Besidesthe built-in LCD you can also use an external monitor/flat panel display/TV
connected to the external monitor port or to the HDMI-Out port (High-Definition
Multimedia Interface) as your display device. The table below outlines the display

options.

4

Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
G&M control panel to configure the full screen display.

Intel Display Mode

Description

Single Display

One of the connected displays is used as the display device

Clone Displays

Both connected displays output the same view and may be
configured independently

Extended Desktop

Both connected displays are treated as separate devices, and
act as a virtual desktop
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Attaching Other Displays

If you prefer to use amonitor or flat panel display, connect it to the external monitor _ Z _
port or HDMI-Out port on the left of the computer. Multiple Display
To Clone Displays: At least one other dis-

play must be attached in

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on. order to view Multiple
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays. Display selection op-
3. Click Operating Mode and select Clone Displays from the menu. tions.

4. Click Apply, and OK to confirm the settings change.

5. You can switch the Primary/Secondary Display from the menu. General Settings

Click General Settings
to access settings the
options for any attached
display.

FigureC- 3
Display > Multiple

Displays (Clone) .
C

Attaching Other Displays C - 5
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To Enable Extended Desktop:

4 1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
i : 2. Gotothe Intel(R) G&M control panel and click Display > Multiple Displays.
Display Settings 3. Click Operating Mode and select Extended Desktop from the menu.
Extended Desktop 4. Click Apply, and OK to confirm the settings change.
You can have different . . .
Colors, Screen Area _CI'Ck the appropriate monitor
and Monitor Refresh icon and drag it to match the
Rates for each display physical arrangement you
e wish to use (e.g. the second-

:Egnmifor can support ary o!isplay may be extended
left/right/above/below  the

You can drag the moni- rimarv disol
tor icons to match the p y aisp ay)

physical layout of your

displays. Icons and pro- Click General_ Settings to
grams may also be make any adjustments re-
d_ragged between the quired.

displays.

FigureC-4
Display > Multiple

Displays (Extended)

C - 6 Attaching Other Displays
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Display Profiles
Y ou can save display settings to be loaded at any time.

1. Goto the Intel(R) G&M control panel and click Display.

2. Configure the General Settings, Multiple Displays, Color Enhancement, Custom
Resolution & Monitor/TV Settings to your preferences.

3. Click Apply, and OK to confirm the settings change.

4. Click the Save button at the top of the General Settings, Multiple Displays or Color
Enhancement menus (under Display Profiles).

5. Type a name for the Profile and click OK.

6. The Profile will be listed under Display Profiles.

7. Select the profile from the pull-down menu and click Apply, and OK to confirm the
settings change.

FigureC-5
Intel® G&M
Profiles

Attaching Other Displays C - 7
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Function Key
Combination

You can use the Fn +

F7 key combination to

toggle through the dis-

play options:

» Notebook Only

» External Display
Only

» Notebook + External
Display

Make sure you give the

displays enough time

to refresh.

Note that HDMI sup-
ports video and audio
signals.

FigureC-6
Screen Resolution
Multiple Displays

(Win 7)

Video Driver Controls

Configuring an External Display in Windows 7

Y ou can also use the Screen Resolution control panel in Windows 7 to configure an

external display.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.

2. Go to the Screen resolution control panel (see “Video Features” on page 1 -
19).

3. Click the Detect button.

4. The computer will then detect any attached displays.

C - 8 Configuring an External Display in Windows 7
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5. You can configure the displays from the Multiple Displays menu.

FigureC-7
Screen Resolution
Multiple Display

Options
(Win 7)
» Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)
» Extend these displays - Treats both connected displays as separ ate devices

» Show desktop only on 1/2 - Only one of your displaysis used.

.|
Configuring an External Display in Windows 7 C - 9
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Using the Windows Logo Key g + P Key Combination to Switch Displays
You can also usethe g + P key combination to quickly change display configura-
tion and modes (thisis particularly useful when attaching a projector) in Windows 7.

Attach your display to the external monitor port or HDMI-Out port, and turn it on.
Press the 2= + P key combination.

An on-screen menu will pop up.

Use the cursor keys (or & + P) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

PN

FigureC- 8

s + P Display

Configuration
Selection
(Win 7)

.|
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HDMI Audio Configuration P

HDMI (High-Definition Multimedia Interface) carries both audio and video signals.

In some cases it will be necessary to go to the Sound control panel and manually Volume Indicator

configure the HDM | audio output as per the instructions below. Click the taskbar volume
indicator [l§ when an

1. Click Start, and click Control Panel (or point to Settings and click Control Panel). HDMI device is select-
2. Click Sound (Hardware and Sound) and click Playback (tab) ed, and you will note that
3. Depending on your display, the playback device may be selected, however in some the icon at the top of the
cases you may need to select the audio device and click Set Default (button). volume level indicator

4. Double-click the device to access the control panel tabs illustrated overleaf. has changed.

< T —

FigureC-9

O Sound - HDMI

Device (set Default)

HDMI Audio Configuration C - 11
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5. Double-click the connected HDMI device (or right-click and select Properties) to
adjust the HDMI settings from the control panel tabs.
6. Click OK to close the control panel (see notes overleaf).

FigureC- 10
HDMI Device
Properties

C - 12 HDMI Audio Configuration
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HDMI Notes

» Connect adevice with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

» To play audio sources through your external display’s (TV or LCD) speakers
you will need to go to the audio configuration control panel on the display and
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out port to your external display.

2. Configure your external display as per the instructions in “Attaching Other
Displays” on page C - 5.

3. Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

4. You can now play video/audio sources through your external display.

HDMI Audio Configuration C - 13

4

Other Applications

If you are using a third
party application to
play DVDs etc. from
any attached DVD de-
vice, you will need to
consult the applica-
tion’s documentation
to see the appropriate
audio configuration
(the application must
support digital to ana-
log translation).
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Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.

.|
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Specifications

Intel® Core i7-3520M (2.9GHz)
4M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3360M (2.8GHz)
3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3320M (2.6GHz)
3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

These processors are available for Model
A computers only:

Intel® Core i7-3612QM (2.1GHz)
6M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3210M (2.5GHz)
3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i3-3110M (2.4GHz)
3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

D - 2 Specifications

Intel® Core i7-2640M (2.8GHz)
4M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2540M (2.6GHz)
3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2520M (2.5GHz)
3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2450M (2.5GHz)
3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2430M (2.4GHz)
3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2370M (2.4GHz)
3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2350M (2.3GHz)
3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B980 (2.4GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B970 (2.3GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B960 (2.2GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B950 (2.1GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Model A:
Mobile Intel® HM77 Express Chipset

Model B:
Mobile Intel® QM77 Express Chipset

15.6"/ 39.62cm 16:9 HD (1366 * 768),
HD+ (1600 * 900) Panel




Dual Channel DDRIII (DDR3)

Two 204 Pin SO-DIMM sockets
supporting DDR3 1333MHz/1600MHz
(real operational frequency depends on
the FSB of the processor)

Memory Expandable up to 8GB (using
1GB/2GB / 4GB SO-DIMM Modules)

Intel® Integrated GPU (Intel® HD
Graphics / Intel® HD Graphics 3000 /
Intel® HD Graphics 4000):

Dynamic Frequency

Intel® DVMT Shared Memory Architecture
up to 1748MB

Microsoft DirectX®10 Compatible (Intel®
HD Graphics / Intel® HD Graphics 3000)
Microsoft DirectX®11 Compatible (Intel®
HD Graphics 4000)

Model B computers only support Intel®
HD Graphics 4000

One 64Mb SPI Flash ROM
AMI BIOS

One Changeable 12.7mm(h) Super Multi/
Blu-ray Combo Optical Device Drive with
SATA Interface (Factory Option)

One Changeable 2.5" / 9.5 mm (h) HDD
with SATA (Serial) Interface

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

Isolated Full Size Keyboard with Numeric
Pad

Built-in Touchpad with Multi-Gesture and
Scrolling Functionality

Specifications

One ExpressCard™ (54/34) Slot

Embedded Multi-In-1 Push-Push Card
Reader

- MMC/ RS MMC

- SD/ Mini SD / SDHC/ SDXC

- MS/ MS Pro/ MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

Two Mini-Card Slots:

Slot 1 for Half Size Mini-Card WLAN
Combo Module with PCle & USB
Interfaces

Slot 2 for Full Size Mini-Card 3G Module
with USB Interface (Factory Option)

Specifications D - 3



Specifications

One USB 2.0 Ports

Three USB 3.0 Ports (Including 1 ACDC
Powered USB Port)

One eSATA Port

One External Monitor Port

One HDMI™ Out Port (with HDCP)
One Headphone-Out Jack

One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

One Docking Port (with Hot Plug
Functionality)

Built-In Intel® 10/100/1000Mb Base-TX
Ethernet LAN

2.0M HD PC Video Camera Module
(Factory Option)

UMTS/HSPDA OR UMTS/HSPDA+ based
3G Module with Mini-Card Interface
(Factory Option)

Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America

Intel® Centrino® Wireless-N 2230 2*2
(802.11 b/g/n) Half Mini-Card PCle WLAN +
Bluetooth Combo Module (Factory Option)

Intel® Centrino® Wireless-N 135 1*1
(802.11 b/g/n) Half Mini-Card PCle WLAN +
Bluetooth Combo Module (Factory Option)

3rd Party Combo WLAN (802.11b/g/n)
and Bluetooth v4.0+LE Half Mini-Card
Module with PCle Interface (Factory
Option)

3rd Party WLAN 802.11b/g/n Half Mini-
Card Module with PCle Interface
(Factory Option)

Intel® Centrino® Advanced-N 6235 2*2
(802.11 a/g/n) Half Mini-Card PCle WLAN +
Bluetooth Combo Module (Factory Option)

Intel® Centrino® Advanced-N 6205 2*2
(802.11 a/g/n) Half Mini-Card PCle WLAN
Module (Factory Option)

Supports Wake on LAN
Supports Wake on USB

For Model B Only:
Supports Wake on RTC alarm (S5) by AC
mode only

Full Range AC/DC Adapter

AC input 100 - 240V, 50 - 60Hz,

DC Output 19V, 3.42A or 18.5V, 3.5A (65
Watts)

Removable 6 Cell Smart Lithium lon Battery
Pack 62.16WH

D - 4 Specifications



Security (Kensington® Type) Lock Slot
BIOS Password

Fingerprint Reader Module

Trusted Platform Module 1.2

For Model B Only:
Intel® vPro Support

LED Indicators - Power/Suspend,
Battery, HDD/ODD, Bluetooth/Wireless
LAN, Num Lock, Caps Lock, Scroll Lock,
CCD

Windows® 7 with Service Pack 1
Windows® 8

All USB / ExpressCard & Card Reader
ports /slots may be switched on/off in BIOS

WLAN Slide Switch
Painted Style Finish

Supports Intel® Anti-Theft Technology
Supports Intel® Smart Connect Technology
Supports Intel® Small Business Advantage

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%

374mm(w) * 256mm(d) * 37.9mm(h)

2.5kg with ODD & Battery

Specifications
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Docking Station Guide

Appendix E: Docking Station Guide

Overview

The docking station provides your computer with an easy connectable desktop environment when portability is
not required. This allowsfor easy connectionsto external displays, USB devices (with afull range of extra USB
ports), audio devices and provides a battery charging facility.

Compatibility

Note that this docking station is compatible with particular computer models with the appropriate docking con-
nector only. Attempting to dock the computer to an incompatible docking system will result in an error message
(inthis case immediately separate the computer from the docking station). Please contact your service center for
full details.

. |
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Docking Station Guide

Computer and Docking Station

The computer may hot or cold dock/undock with the docking station, i.e. the computer may be powered on (hot
docking/undocking) or powered off (cold docking/undocking) when docking or undocking. However if you in-
tend to hot dock/undock the system then make sure that the hot key driver, provided on the computer’s Device
Drivers & Utilities + User’sManual disc, isinstalled.

Hot Docking/Hot Undocking & Power Saving Modes

If the computer is in a power-saving state (Sleep or Hibernate), or is resuming from a power saving state, do not attempt to
hot dock or hot undock the system.

Moving the Docking Station

Note that if the notebook is docked with the docking station, do not attempt to move the docked unit in order to avoid losing
connection. If you wish to move the docking station, then make sure you undock the notebook from the docking station before

doing so.

Docked System Power

The system power for a docked unit should be provided only by the docking station’s AC/DC adapter plugged
into the DC-In jack at the rear of the docking station (make surethe computer’s AC/DC adapter isnot used
at any timewhen thecomputer isdocked). Follow theinstructions on the next pagesto safely dock and undock
your computer with the docking station.

.|
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System Map: Front View Figure E - 1
System Map Front

1. Power Button LED
9 o 2. Backup Button (if a
Hard Disk is
e installed in the
9 Device Bay)
3. Lock Switch
(5] 4. Notebook Eject
Latch
5. Notebook
Placeholder

6 @ 6. Retaining Pins
7. Docking Connector

() (7] (3] 8. Eject Pins

Backup Button

Note that when the backup button is used to backup the computer’s hard disk/files to the
docking station, in conjunction with the backup application, if a hard disk is installed in the
docking station’s bay.
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Figure E - 2 System Map: Rear View
System Map Rear

1. Security Lock Slot
L ey o 00 6 0 6 6 00 g 44 ¢
3. DVI-D Out Port
4. HDMI-Out Port
5. External Monitor
Port o 9 9 e 6 @
6. RS232 (Serial)
COM Port
7. RJ-45 LAN Jack
8. DC-In Jack
9. Headphone Jack (7] (3]

16. Microphone Jack
11. S/PDIF-Out Jack @ @ @ @ @ @

12. USB 2.0 Ports

LAN Jack & Docking

Note that when the computer is docked with the docking station, the notebook’s LAN Jack
can no longer be used as the network jack. When the system is docked use the docking sta-
tion’s LAN jack as the network jack.
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Power Button LED & Lock Switch LED Indicator

Icon Color Description
Orange DC Power is Plugged In and the Computer is Off or in Hibernate Mode*
Green The Docking Station is On or in Sleep Mode

Table E - 1 - Power Button LED & Lock Switch LED Indicator

*To confirm the computer’s power status check the LED Power Indicators on the computer itself.
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Figure E - 3 System Map: Left & Right Views

System Map
Left & Right Views

1. Bay with HDD or
Dummy Caddy
OR 0
2. Bay with Optical
Device Drive (DVD)
3. Powered USB 3.0
Port
4. USB 3.0 Ports (2]

USB Port Power

Note that power to the notebook computer and docking station’s USB ports may be enabled/
disabled in the notebook computer’'s BIOS settings (see the BIOS guide in Chapter 5 of the
notebook’s user manual).
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Cold Docking the Computer to the Docking Station

1.
2.

3.

Remove all packing materials and place the docking station on a stable surface.
Securely attach any peripherals you want to use with the docking station (e.g. keyboard and mouse) to their

ports.
Attach the AC/DC adapter to the DC-In jack at the rear of the docking station, and then plug the AC power cord

into an outlet, and connect the AC power cord to the AC/DC adapter.
The power button LED o on the docking station will be

Figure E - 4 - Docking Station with AC/DC Adapter Plugged

Cold Docking the Computer to the Docking Station E - 7
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Docking Station Guide

5. Make sure the computer’s hot key driver is installed (especially if you intend to hot dock the system).

6. Remove the AC/DC adapter from the notebook computer and then close the computer’s lid/LCD and turn it over
(if you are using the optional 9 cell battery make sure you remove the battery before attempting to dock
the computer with the docking station).

7. Slide the notebook computer’s docking port cover latch in the direction of the arrow at point @ to open the
cover (failure to open the cover of the docking port before connecting the computer to the docking station may
result in irreparable damage to the connector on the docking station).

AN
I

Docking Port Cover

Make sure you keep the cover closed when the computer is not docked in the station. This will
help prevent foreign objects and/or dust getting in to the contact area.

Figure E - 5 - Opening the Docking Port

E - 8 Cold Docking the Computer to the Docking Station
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8. Make sure that the notebook computer’s AC/DC adapter is NOT ATTACHED to the computer’s DC-In
jack and that the computer is OFF.

9. Ensure that the lock switch on the docking station is in the unlock position.

10. Press the computer down onto the docking station so that the docking connectors line up.

11. Slide the lock switch on the docking station in to the lock position @.

12. Press the power button @ on the docking station (or power button on the notebook) to turn it on.

13. The Power LED on the docking station will be green and you can then use the docking station ports.

o L&
Moving the Docking Station

9 Note that if the notebook is docked with
the docking station, do not attempt to
move the docked unit in order to avoid
losing connection. If you wish to move
the docking station, then make sure you
undock the notebook from the docking
station before doing so.

AC/DC Adapter

Use only the docking station's AC/DC
adapter plugged-in to the docking sta-
tion’s DC-In jack to power the computer.
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Figure E - 6 - Slide the Lock Switch
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Cold Undocking the Computer from the Docking Station

1. Shut the computer down as per the normal Windows shutdown (select Shut Down from the Start menu in
Windows 7) procedure (the Power LED on the docking station will be ).

Slide the lock switch o on the docking station in to the unlock position.

3. Lift the eject latch Q fully in the direction indicated to unlock the docking station, while carefully holding the

notebook computer with one hand.
4. You can then lift the notebook computer off the docking station.
5. After disconnecting the computer from the docking station, slide the docking port cover latch @ in the direction

of the arrow.

n

@
0

Figure E - 7 - Slide the Switch to Unlock & Lift the Eject Latch

E - 10 Cold Undocking the Computer from the Docking Station
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Hot Docking the Computer to the Docking Station

1.
2.

3.

Remove all packing materials and place the docking station on a stable surface.
Securely attach any peripherals you want to use with the docking station (e.g. keyboard and mouse) to their

ports.
Attach the AC/DC adapter to the DC-In jack at the rear of the docking station, and then plug the AC power cord

into an outlet, and connect the AC power cord to the AC/DC adapter.
The power button LED o on the docking station will be

Figure E - 8 - Docking Station with AC/DC Adapter Plugged

Hot Docking the Computer to the Docking Station E - 11
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Docking Station Guide

Make sure the computer’s hot key driver is installed for hot docking/undocking the system.

The computer should be on, however remove the AC/DC adapter from the notebook computer and then close
the computer’s lid/LCD and turn it over (if you are using the optional 9 cell battery you cannot hot dock the
computer with the docking station).

7. Slide the notebook computer’s docking port cover latch in the direction of the arrow at point @ to open the
cover (failure to open the cover of the docking port before connecting the computer to the docking station may
result in irreparable damage to the connector on the docking station).

5.
6.

AN
I

Docking Port Cover

Make sure you keep the cover closed when the computer is not docked in the station. This will
help prevent foreign objects and/or dust getting in to the contact area.

Figure E - 9 - Opening the Docking Port

E - 12 Hot Docking the Computer to the Docking Station
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Ensure that the lock switch on the docking station is in the unlock position.
Press the computer down onto the docking station so that the docking connectors line up (the Power LED on

the docking station will be orange).
10. Slide the lock switch on the docking station in to the lock position @.
11. The Power LED on the docking station will be green and you can then use the docking station ports.

© ©

SN
1

Moving the Docking Station

9 Note that if the notebook is docked with
the docking station, do not attempt to
move the docked unit in order to avoid
losing connection. If you wish to move
the docking station, then make sure you
undock the notebook from the docking
station before doing so.

AC/DC Adapter

Use only the docking station's AC/DC
adapter plugged-in to the docking sta-
tion’s DC-In jack to power the computer.

Figure E - 10 - Slide the Lock Switch

.|
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Hot Undocking the Computer from the Docking Station

Hot undocking using Windows:

1. When the system is docked click the icon &; in the taskbar notification area and click Safely Remove Hard-
ware and Eject Media @ (Figure E - 11) from the menu.

2. Select Eject Docking Station @ and the Undock Complete @ message will appear in the notification area of
the taskbar (the docking power LED will be Orange at this point and the ports, buttons and attached devices on
the docking station will not work).

3. Follow steps 2 to 5 of the cold undocking procedure on page E - 10 to complete the undocking process.

\ A/
2\
L
Battery Condition @ ( @

Note that if you attempt to hot
undock the system when the
battery level is low (default
below 10%) you will receive

an error message. In this
case shut the system down
to cold undock the notebook
from the docking station, or O
let the battery charge suffi-

ciently until it is no longer 9
classed at a low level.
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Figure E - 11 - Using the Windows System to Hot Undock the Computer
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Hot undocking using the Control Center:

1. Make sure the computer’s hot key driver is installed for hot docking/undocking the system.

2. Pressthe Fn + Esc key combination to run the Control Center.

3. Click the docking icon 3}; @ in the Control Center (the icon displays the current docking status).

4. The docking icon will change to the undock icon ;:*_r @ to display the current status and the Undock Complete
© message will appear in the notification area of the taskbar (see over).

AN
I

Battery Condition

Note that if you attempt to
hot undock the system
when the battery level is low
(default below 10%) you will

receive an error message.

In this case shut the system
Q o Oe down to cold undock the
notebook from the docking
station, or let the battery
charge sufficiently until it is

e no longer classed at a low
level.
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Figure E - 12 - Using the Control Center to Hot Undock the Computer
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o

Press the Fn + Esc key combination to run the Control Center.

6. The docking power LED will be at this point and the ports, buttons and attached devices on the docking
station will not work.

7. If you do not wish to separate the notebook and docking station at this point you can click the icon :-f: in the
Control Center to redock the system.

8. Follow steps 2 to 5 of the cold undocking procedure on page E - 10 to complete the undocking process.
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Power Button Configuration

To prevent your computer from entering a power-saving state if you choose to work with the lid/LCD closed,
then it may be necessary to redefine what the computer is set to do if the lid/LCD is closed when plugged in.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Power Options (Hardware and Sound).

Click Choose what closing the lid does (in the left pane).

Set the When | close the lid: option when the computer is plugged in to Do nothing.
Click Save Changes and close the control panel.

agrwnE

Hot Docking/Hot Undocking
& Power Saving Modes

If the computer is in a power-sav-

ing state (Sleep or Hibernate), oris
resuming from a power saving
state, do not attempt to hot dock or
hot undock the system.
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Figure E - 13 - Power Options (Choose what closing the lid does)
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Docking Station Ports & Jacks

Thefollowing will give aquick description of theinterface (ports & jacks) which allow your docking station and
computer to communicate with external devices, connect to the internet etc. When the notebook is docked to the
docking station al the ports on the docking station will function, however only some of the ports on the notebook
will function (see the note alongside each item for specific information..

Item Description Note

COM/RS232 Serial Port

The COM/serial is a communication interface for data transfer,
through which information transfers in or out one bit at a time.
This port can be used to connect the computer to devices such

This port is supported in the
Windows environment and
at the DOS prompt, however

as terminals and peripherals. there is no COM mouse

support.
DC-In Jack Plug the supplied AC/DC adapter into this jack to power your | Use only the docking
— docking statio and docked computer. station’s AC/DC adapter

plugged-in to the docking
station’s DC-In jack to power
the computer.

DVI-D Out Port The DVI-D Out (Digital Visual Interface-Digital) Port is a video
connector interface supporting digital displays only. This allows
you to connect an external monitor, TV or Flat Panel Display etc.

as a display device by means of a DVI-D compatible cable.

O
o
0
S,
>
Q
n
—t
=
o
-

E - 18 Docking Station Ports & Jacks



Docking Station Guide

Item

Description

Note

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel
Display, to get dual video or simultaneous display on the LCD
and external monitor/FPD.

Use only the external monitor
port on the docking station
when the system is docked.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an
audio/video connector interface for transmitting uncompressed
digital streams. This allows you to connect an external monitor,
TV or Flat Panel Display etc. as a display device by means of a
HDMI cable. Note that HDMI carries both audio and video
signals.

You can use the HDMI ports
on both the docking station
and the notebook, connected
to two separate displays,
when the system is docked.

Headphone-Out Jack

Headphones or speakers may be connected through this jack.
Note: Set your system’s volume to a reduced level before
connecting to this jack.

Microphone-In Jack

Plug an external microphone in to this jack to record on your
computer.

You can use the headphone
and microphone jacks on
either the computer and/or
docking station when the
system is docked.

RJ-45 LAN Jack

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the
LAN port.

Note that when the system is
docked the notebook’'s LAN
Jack can no longer be used
and you must use the
docking station’s LAN jack as
the network jack only.

.|
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Item

Description

Note

Security Lock Slot

To prevent possible theft, a Kensington-type lock can be
attached to this slot. Locks can be purchased at any computer
store.

S/PDIF-Out Jack

This S/PDIF (Sony/Philips Digital Interface Format) Out Port
allows you to connect your DVD-capable PC to a Dolby AC-3
compatible receiver for “5.1” or ‘dts’ surround sound.

USB 2.0/1.1 Ports*

USB 3.0 Ports

3.0

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1
compliant) are for low-speed peripherals such as keyboards,
mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners
etc. Devices can be plugged into the computer, and unplugged
from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure
you use the power supply which comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0
ports are colored black. USB 3.0 will transfer data much faster
than USB 2.0, and is backwards-compatible with USB 2.0.

Note: The powered USB 3.0 port function is designed to help
charge USB compliant devices, but is not designed to allow
their operation.

You can use the ports on both
the computer and the docking
station when the system is
docked.

*Note: The powered USB
3.0 port (see Figure E-3
on page E - 6) will supply
power when the docking sta-
tion is powered by the AC/DC
adapter plugged into a work-
ing outlet, (this may not work
with certain devices). The
notebook does not need to be
docked for this to function.
There is no LED to indicate a
charge status on the docking
station.
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Multiple Displays

Any two of the following displays may be enabled simultaneously when the system is docked. Y ou can toggle
through the display options by using the Fn + F7 key combination (make sure any attached displays are powered
on).

The notebook’s LCD panel

An external display attached to the notebook’s HDMI port.

An external display attached to the docking station’s external monitor (VGA) port.

An external display attached to the docking station’s DVI-D port.

An external display attached to the docking station’s HDMI port.

aprwbhE

BIOS Controls - USB ports, Card Reader & ExpressCard

Note that power to the notebook computer’s USB ports, card reader and ExpressCard may be enabled/dis-
abled in the notebook computer’ s BIOS settings (see the BIOS guide in Chapter 5 of the notebook’ s user man-
ua). The USB 3.0 Power item and Power ed USB 2.0 Port Power settingsinthe BIOSwill also affect the power
supplied to the docking station’s 4 * USB 3.0 portsand 3 * USB ports respectively.

The notebook’ s card reader and ExpressCard will continue to function when the system is docked as long as
they are not disabled in the BIOS.

.|
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One Button Hard Disk Backup

When the system is docked you can pressthe Har d Disk Backup Button (@ Figure E - 14) to launch the Win-
dows 7's Backup and Restor e function. If you do not have a hard disk installed in the docking station you can
set the Windows 7's Backup and Restore application to backup to any attached hard disk, CD/DVD or non system
partition of your computer.

Figure E - 14 - Front View (HDD Backup Button)
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Hard Disk Backup Procedure

1. Press the hard disk backup button.
2. Windows 7’s Backup and Restore application will be launched.
3. If you are on the first run of the program click “Set up backup”, or “Back up now” thereafter.
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Figure E - 15 - Back Up Now / Set Up Backup
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You can then select where you want to save the backup (click the storage media required and click Next).
You can then select what you want to backup on a regular schedule (you can let Windows choose or select

files and folders yourself).
6. Itis recommended you let Windows choose (however if you like to store your files in non regular directories it

may be best to choose yourself).

ok

Click “How does Windows choose what filesto
backup?” to check what files are backed up.

Figure E - 16 - Where to Backup/ What to Backup
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7. You can review the backup settings before running the backup.
8. Click the Change schedule button to change the time the backup is run.
9. Click “Save Settings and run backup” to begin the backup process.

Every Sunday at 7:00 PM Change schedule

Save settings and run backup l[ Cancel
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Figure E - 17 - Backup Schedule & Progress
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Hard Disk Restore Procedure

1. Press the hard disk backup button.
2. Windows 7’s Backup and Restore application will be launched.
3. Click “Restore my files”.

Restore my files

¥ Recover system settings or your computer

Figure E - 18 - Restore My Files
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4. You can browse any attached devices for files or folders to restore (or click “Choose a different date” to choose

a restore file/folder from different date).
5. Click Next and choose the original location, or choose a new location and then click Restore (Windows may

prompt you if you need to replace any files).

4,/©

Figure E - 19 - Restore Files
6. Click Finish when the process is complete.

.|
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7. If your computer has had a problem and you need to recover your computer to an earlier point you can click
“Recover system settings or your computer” (see Figure E - 18 on page E - 26).

Click “Open System Restore.”
9. You can then choose the recommended restore point (Recommended Restore), or “Choose a different

restore point” and click Next.

©

Figure E - 20 - Restore System Files and Settings

10. Click Finish to confirm the restore point and Yes to begin the process.
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Specifications

One Changeable 12.7mm(H) Super Multi ODD / Blu-ray Combo
ODD or 2.5" /9.5 mm(H) HDD Caddy with SATA (Serial)
Interface (Factory Option)

Three USB 2.0 Ports

Four USB 3.0 Ports (including 1 * powered USB port)
One External Monitor Port

One DVI-D Out Port

One HDMI™ QOut Port (with HDCP)
One Headphone-Out Jack

One Microphone-In Jack

One S/PDIF-Out Jack

One RJ-45 LAN Jack

One RS232 (Serial) COM Port
One Docking Port (Hot Plug)

One DC-In Jack

Power Button, Notebook Eject Latch, Docking Lock Switch &

HDD Backup Button

Docking Station Guide

Full Range AC/DC 90W Adapter
AC input 100 - 240V, 50 - 60Hz, DC Output 19V, 4.74A

Security (Kensington® Type) Lock Slot

Adapter Power/System
System Operation Indicator

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%
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380mm (w) * 206mm (d) * 33mm (h)
0.85kg
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Windows 8

Appendix F: Windows 8

Overview

This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 8 OS.

Y ou can refer to the main manual for details of driversrequired, audio & video information, BIOS, modul es etc.
However any information specific to Windows 8 will be included in this Appendix, as well as details on how to
navigate the Windows 8 M etro User Interface to access the applications, control panels, taskbar etc.

4

Windows 7/8 OS

In order to run Windows 7 or 8 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 7 or 8 (64 bit) your computer requires a minimum
2GB of system memory (RAM).
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Windows 8

Windows 8 Start Screen & Desktop

The apps, control panels, utilities and programs within Windows 8 are accessed from the M etr o user interface’ s
Start screen and/or Windows Desktop. The Desktop (which runs as an app within the Start screen) can be ac-
cessed from the Desktop item inthe Start screen (or by using the WindowsL ogo Key g8 + D key combination).

Figure F - 1 - Windows Start Screen

F - 2 Windows 8 Start Screen & Desktop
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Apps & Tiles

The Windows 8 Start screen will contain a number of apps, and many more will be installed as you add more
applications etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of
the screen in order to view al the necessary apps.

Accessing Pining/Unpinning All Apps

Y ou can add and remove the tiles for apps and control panelsin the Start screen. Right-click on a blank area of
the Metro Ul Start screen and you will seethe All Appsicon. Click the All Appsicon to display all theinstalled
applications etc. Right-click any icon to bring up the menu at the bottom of the screen. Y ou can then click the
appropriate icon to pin the app to (or unpin from) the Start screen, or to the taskbar in the Desktop applica-
tion.

® @ ©® @ 6

Pin to Start Pin to taskbar Uninstall Open new n as Open file
window admlm strator location

Figure F - 2 - All Apps

Windows 8 Start Screen & Desktop F -3
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Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows L ogo Key g@ + D key
combination) you can use lower |eft hot corner to switch between the Start screen and the Windows Desktop.
To do so move your mouse to hover over the bottom left corner of the screen and click the pop-up.

When you move to the lower left hot corner in the Start screen itself it will take you back to your most recently
used app.

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
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Figure F - 3 - Desktop
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When the Desktop app is running you can right-click the lower left hot corner (or use

the Windows L ogo Key 5@ + X key combination) to bring up an advanced context Va

menu of useful features such as Control Panel, Programs and Features, Power Op-

tions, Task Manager, Search, Windows Explorer, Command Prompt, Device Man- Display Most
Recently Used

ager and Network Connections etc.

Programs and Features
Mohbility Center

Power Options

Event Viewer

System

Device Manager

Disk Management
Computer Management
Command Prompt

Coemmand Prompt (Admin)

Task Manager
Control Panel
File Explorer
Search

Run

Desktep

Move the mouse to the bottom left of the screen

and right-click to access the menu.

Figure F - 4 - Advanced Context Menu (Right-Click lower left hot corner)

Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to
get back to the most re-
cently used app.

To view all the most re-
cently used apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Windows 8 Start Screen & Desktop F -5
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Windows 8 Charms Bar

Theright side of the screen displays the Windows 8 Charms Bar. The Charms Bar contains the Sear ch, Share,
Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right
corners of the screen, and then hover over one of the itemsin the Charms Bar to activate it (the bar will be black
when it is active), or use the Windows L ogo Key g@ + C key combination.

Figure F - 5 - Start Screen with Charms Bar
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Charms Bar Items

* Search E: You can search for any file, application, apps and control panel settings with instantaneous
results.

« Sharel@): Thisbutton is used to share information with people viamail or social networks.

 Sart .: Click to bring up the Start Menu (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen).

» Devices[B]: Click this button to change connected peripheral device settings e.g. an external display.

o Setti ngsE]: This button gives instant access to the computer settings, such as Network, Audio, Brightness,
Notifications, Power and Keyboard (click Change PC Settings to activate the PC Settings menu).

0 -

- i) -O: 4

Wierridsd & Eaahiges Charms Bar - TouchPad Access
To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of
Notifications Power Keyboard the pad resting on the computer).

Move your finger across to the left on to the TouchPad.
The Charms Bar will then pop-up.

wnn

Change PC settings
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Figure F - 6 - Settings Menu
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Windows 8 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is much the same as that in Windows 7, however it can be accessed in a number of waysin Windows 8.

* Click Search inthe Windows Charms Bar (see previous page) and the search pane will pop out. Type
Control Panel and select it from the results to the | eft.

Figure F - 7 - Search (Control Panel)

* Click on Computer inthe Start screen, click on Computer in the top menu and select Open Contr ol
Panel from the ribbon.
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Figure F - 8 - Open Control Panel (Computer)
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* Whenin the Desktop app (this does not apply to the Start screen) click on Settingsin the Windows
Charms Bar and select Control Panel from the menu.

Settings

\ Control Panel ,

Figure F - 9 - Settings Charms Bar (Desktop App Only)

* Right-click on ablank area of the Metro Ul Start screen, click the All Appsicon and click Control
Panel.
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Figure F - 10 - All Apps - Control Panel
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» Right-click the lower left hot corner to bring up the menu and select Control Panel (see Figure F - 4 on
pageF - 5).

4

Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key § and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Wlndows Iogo key & and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
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Windows 8 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of thetask-
bar. In Windows 8 the taskbar is accessed from the Desktop application. If you are in the Start screen you will
need to click the Desktop app to switch to the Desktop.

The taskbar is displayed in much the same way as it was in Windows 7, and you can see the notification area of
the taskbar in the bottom right of the screen. Some of the Control Panels and applications referred to during the
course of this manual can be accessed from here.

Figure F - 11 - Desktop Taskbar

Y ou can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see Accessing
Pining/Unpinning All Apps’ on pageF - 3).
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LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Icon Color Description Icon Color Description
Orange AC/DC Power is Plugged In Green The (optlor_lal) Wireless LAN Module
is Powered On
The Powered USB Port is On Win 7 - The (optional) Bluetooth
(System Off) Module is Powered On
Blinking Orange - .
Orange The Camera is in Use 9 Win 8 - The (optional) Bluetooth
(System On) Module is Installed (this is not a
Y power on/off indicator in Windows 8)
Green The Computer is On Ll) Blue Power Button
Blinking The Computer is in Sleep Green Hard Disk Activity
Green Mode
. . Number Lock Activated
Orange The Battery is Charging El Green (to activate press Fn & Num LK)
Green The Battery is Fully Charged Green Caps Lock Activated
Blinking The Battery has Reached —~ Green Scroll Lock Activated
Orange Critically Low Power Status (to activate press Fn & Scr Lk)

F -12 LED Indicators
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Keyboard - Windows 8

The main difference between the Windows 7 & Windows 8 keyboardsisin the func-
tion of theWindows L ogo Key & Menu/Application Key (inthe Start screen), oth-
erwise the keyboard functions are identical (see “ Keyboard” on page 1 - 9).

4

Windows Logo
Keyboard Shortcut

Use the Windows logo
key 3@ + D key com-
bination to switch be-
tween the Start screen
and Windows Desktop
(see Table F - 2 over-
leaf for further informa-

tion).
Menu/Application
Venu/Application Key Keyboard Shortcut
H| ‘ When the Desktop app
— — iS running you can use

the Menu/Application

Figure F - 12 - Keyboard key E| on the key-

Thefunction/hot key indicators function in the same manner as outlined for Windows Sg?{:xtt%eiijﬂiypgfz =
7 on “Function/Hot Key Indicators’ on page 1 - 10. However the indicatorswork | mouse right-click. In -
113 H H ” . . Q

under the Desktop app (see” Desktop Application” on page F - 4) and not under the | the Start screen this o
Start screen (except for the Mute, Volume and Brightnessindicators which usethe | function is useful to =
standard Windows 8 indicators). Quickly display the Al @
Apps icon. (06}

Keyboard - Windows 8 F - 13
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Keyboard Shortcuts
Thefollowing Windows L ogo Key (Winkey) keyboard shortcuts are useful for navigation/operation in Windows 8.

Windows Logo =@ Key + Description
Tap Winkey Toggle between the Start screen and the foremost running app or the Windows Desktop
C Display Charms menu
D Switch to the Windows Desktop and toggle show Desktop
E Switch to the Windows desktop and launch Windows Explorer with Computer displayed
F Display file Search

I Open the Settings charm

Open the Connect charm

Lock the computer and display the Lock screen

Display the Second Screen menu (see Figure F - 14 on page F - 16)

Switch to the Windows Desktop and display the Run dialog box

N| 0| O | X

Access the App Bar (see Figure F - 4 on page F - 5)

Table F - 2 - Keyboard Shortcuts
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Function/Hot Key Indicators & Control Center

The function/hot key indicators and Control Center function in the same manner as outlined for Windows 7 (ex-
cept for the Mute, Volume and Brightness indicators which use the standard Windows 8 indicators) in on
“Function/Hot Key Indicators’ on page 1 - 10 and “ Control Center” on page 1 - 11. However both of these
functionswork under the Desktop app (see” Desktop Application” on page F - 4) and not under the Start screen,
and the Control Center does not feature the wireless/Bluetooth buttons and Airplane Mode etc.

4

Control Center

Click on any button to turn any of the modules (e.g. Touch-
Pad, Camera) on/off.

Click on the power conservation modes to switch between
Performance, Balanced or Energy Star modes (see page
3-10). To remove the Power Conservation Modes screen
just click in a blank area of the icon or press a key on the
keyboard.

Click on the buttons (or just click and hold the mouse but-
ton) to adjust the slider for Brightness/Volume.

Click on Display Switch and click to choose a display mode
from the menu (see page C - 10).
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Figure F - 13 - Control Center
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Per sonalization) in Windows 8 in the same manner as Windows 7 running the Desktop app (see “ Desktop
Application” on page F - 4 and Appendix C). In Windows 8 it is possible to quickly configure external displays
from the Devices menu item in the Charms Bar (see “Windows 8 Charms Bar” on pageF - 6).

To Configure Displays from Devices (Charms Bar):

Attach your display to the external monitor port or HDMI-Out port, and turn it on.

2. Go to the Start screen and select Devices in the Charms Bar.

3. Click Second Screen.

4. Click on any one of the options from the menu to select Duplicate, Extend or a Single display.

L

Devices
Start

There’s nothing to send right now.

I:T Second screen
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Figure F - 14 - Second Screen (Devices)
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Power Options

Power Options can be accessed from the Control Panel in the same manner as Windows 7 from the Desktop app.
The Power item in Settingsin the Charms Bar in Windows 8 may be used to Shut down, Restart or send the

computer to Sleep.

Shut Down, Restart or Sleep

1. Gotothe Charms Bar and click Settings.
2. Click Power .

3. Select Sleep, Shut Down or Restart.

Sleep

0—] Shut down 2
Fau o

-b'd

(LEVETEL  Restart Brightness

2 O

Matifications Power Keyboard

Change PC settings
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Figure F - 15 - Power (Settings)
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Ctrl + Alt + Delete Key Combination
You canusethe CTRL + ALT + DEL key combination from almost any of the Windows 8 interfaces/apps to
bring up afull-screen displaying L ock, Switch User, L og off, Change a password and Task M anager options.
If you click the Power iconin the lower right corner of the screen a power management option menu appears to
display Sleep, Shut down, and Restart.

Figure F - 16 - CTRL + ALT + DEL Menu

To fully control al the power options (including Hibernate mode) go to the Power Options control panel and
configure the power button, sleep button and lid (see Figure F - 17 on page F - 19) to perform the function se-
lected.
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Wake On LAN Settings

If you require your computer to wake up from network activity in Windows 8 then ﬁ
make sure that the computer is either in Sleep or Hiber nate. The power/sleep button Wake On LAN
(Fn + F4 key combo) and closed lid may be set to send the computer in to a power- Support

saving state. Click Choose what the power buttons do on the left menu in Power (Windows 8)
Optionsto bring up the menu.

Wake-On-LAN is only
supported from Sleep or

Hibernate states in
Windows 8.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows 8.
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Figure F - 17 - Power Options Define Power Buttons
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Running Metro Ul Apps

. To run apps in the Metro Ul in Windows 8 you will need to check that the Screen
Screen Resolution Resol Uti d User A t Control ti atible with the svst
for Metro Style Apps esolution and User Account Control Settings are compatible with the system re-

(Windows 8) quirements:

Sl e tie @ Screen Resolution Settings

LETEERVEEEIERE 1. Switch to the Windows Desktop (click the app or use the Windows logo key &g + D
apps will run s key combination).

1024x768. 2. Right-click a blank area of the Windows Desktop and select Screen Resolution.

3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably

Ui lesa ) 1366 * 768 or above (see sidebar).
required to support all

the features of Windows
8 (including multitasking
with snap) is 1366x768.

NG
A&

These specs are the
minimum screen resolu-

tion that supports all the
features of Windows 8 | |
on a useful physical

size.
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Figure F - 18 - Screen Resolution
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User Account Control Settings

If your computer meets the minimum screen resolution requirements, and still you can't run Metro apps, then
that you have to check the status of User Account Control (UAC). Metro apps may fail to open when the UAC
isturned off. To check whether the UAC is on or off, follow the instructions below.

1.
2.

3.

Open the Control Panel (see “Windows 8 Control Panel” on page F - 8).

Click on User Accounts and then click on Change User Account Control settings (or click System and
Security and click Change User Account Control Settings under Action Center).

If the slider is in the Never notify position, then the UAC is disabled.

To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes
to my computer (default) position, and then click OK.
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Figure F - 19 - User Account Control
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Drivers & Utilities

Make sure you install all the drivers and uti lites for your system. Follow the instructionsin Chapter 4 “ Drivers
& Utilities” on page 4 - 1/*Modules & Options” on page 7 - 1 for installing al the basic system drivers and
module drivers for Windows 7 & 8.

However note that the USB 3.0, PC Camera and 3G drivergapplications are not required for Windows 8.
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Driver Installation (Windows 8)

1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.

BD-RE Drive (E:) My Disc

Tap to choose what happens with this disc.

4

Driver Installation

If you miss the message above you can eject the De-
vice Drivers & Utilities + User's Manual disc and then
reinsert it.

Alternatively double-click the disc icon in Comput-
er (use the Windows logo key == + E key combina-
tion to go to Computer in Windows Explorer).

Figure F - 20 - Autorun Driver Installation Disc

4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

5. Check the driver installation order from Table F - 3, on page F - 24 (the drivers must be installed in this
order) which is the same as that listed in the Drivers Installer menu below.

6. Click to select the driver you wish to install, (you should note down the drivers as you install them).

7. Follow the instructions for each individual driver installation procedure as listed on the appropriate pages.

=
>
o
o
=
(0]
o

. |
Drivers & Utilities F - 23



Windows 8

Win 7 SP1/Win 8 Driver Page # Win 7 SP1/Win 8 Driver Page #
Chipset Page 4 - 6 (PSCeZeC;;nge;a[l:({ri\zlg is not required for Windows 8
Video (VGA) Page 4 -6 Wireless LAN Module (see Page F - 30)
LAN Page 4 -6 Fingerprint Reader Module Page 7 - 35
CardReader Page 4 -6 3G driver is not required for Windows 8 (see Page F - 42)
Touchpad Page 4 -6 Bluetooth & WLAN Combo Module (see Page F - 37)
Hot Key Page 47 | (rocuired fo hard disks i AHCI mode) | P29% 777
USB 3.0 driver is not required for Windows 8 Trusted Platform Module Page 7 - 85
MEI Driver Page 4 -7 Intel® Smart Connect Technology Page 7 - 99
Audio Page 4 -7 Intel® Wireless Display Application Page 7 - 103

Table F - 3 - Driver Installation
All drivers provided are for Windows 7 with Service Pack 1 or Windows 8.
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.
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PC Camera (Windows 8)

Usethe Fn + F10 key combination (see“ Function/Hot Key I ndicators’ on page 1 - 10) or Control Center but-
ton to toggle power to the PC Camera module.

When the PC Cameraisin use the LED indicator to the left of the camera will be illuminated in red (see @
Figurel-2on pagel- 6).

Note that you need to use the Camera app in Windows 8 to take pictures and capture video (the camera appli-
cation listed in Chapter 7 isfor Windows 7 only).
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Metro Ul Camera App

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
2. Run the Camera app from the Metro Ul by clicking on the Camera app icon

3. The camera interface is a translucent app bar with three buttons.

Figure F - 21 - Camera App Bar
» Cameraoptions.. Click this button to open a window with three main options:

4 Camera options
Camera Options Photo resolution

+ Resolution (determined by the camera spec) 01 MP &3) v
» Audio device (select microphone to use) Audio device

) . . Microphone (Realtek High Defin.. w
* Video Sabilization (atoggle based on spec of the

camera) Video stabilization
off i

More
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Figure F - 22 - Camera Options
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You can aso click on Moreto adjust Brightness, Contrast and Flicker (if you find that the video screen in
the camera program is flickering, you can try to adjust the setting here),

More options

oo

3.
[l=]
0

=
m
i
A

Contrast

Flicker

60 Hz v

50 Hz

Figure F - 23 -More Camera Options

» Timer: Thisbutton will start athree second countdown before the system takes a still photo or video record-
ing starts.

* Video Mode: This button toggles between still photo mode (transparent button m) and video recording
mode (highlighted white button g ).

PC Camera (Windows 8) F - 27
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Taking Pictures/Capturing Video

Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
Run the Camera app from the Metro Ul by clicking on the Camera app icon

Click to select the timer if you require a countdown before capture.

Click to select either photo or video modes.

Click in the main window to take a picture or start video capture (if video capture begins a timer will appear in
the bottom right corner of the screen).

To stop video capture click the main window again.

Captured photos and videos will be saved to a Camera Roll folder within the Picture folder in Libraries.
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Figure F - 24 - Libraries - Pictures
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10.

11.
12.
13.

14.

Windows 8

A scroll arrow will appear on the left side of the screen after any pictures/videos have been captured.

Click the arrows (on either side of the screen) to browse through the captured photos/video, and back to the
Camera app.

Clicking on a captured photo will bring up an app bar with Crop and Delete buttons.

Figure F - 25 - Crop & Delete Buttons (for Still Photos)

Use the handles to Crop any captured picture, and click OK to save the changes made.
Click Delete to delete any captured photo (note that no prompt will appear to confirm the delete).
Right-click any captured video to bring up app bar with Trim and Delete buttons.

Figure F - 26 - Trim & Delete Buttons (for Video Files)

Use the buttons at either end of the slider to adjust the video length and click OK to save the changes made.
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Wireless LAN Settings (Windows 8)

If you haveincluded an Intel® or 3rd Party WirelessLAN (or WLAN & Bluetooth combo) modulein your pur-
chase option, make sure that the WLAN module is on before installing the driver.

Usethe Fn + F11 key combination (see“ Function/Hot Key Indicators’ on page 1 - 10) or Control Center but-
ton to toggle power to the Wireless LAN module. Make sure you install the drivers in the order indicated in
Table4 - 1, on page4 - 3. See “ 3rd Party 802.11b/g/n Driver Installation (for WLAN Module)” on page 7 - 13/
“3rd Party 802.11b/g/n Driver Installation (for Combo Modules)” on page 7 - 13 or “Intel® WLAN Driver In-
stallation” on page 7 - 14 for driver installation information, however see overleaf for WL AN configuration in-
formation in Windows 8.

Note that you need to install both the WLAN & Bluetooth driversfor the Intel and 3rd party WLAN & Blue-
tooth Combo modules.
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WLAN Configuration in Windows 8

Y ou can configure a wireless connection using one of the following options, however make sure the Wireless
LAN moduleisturned on (and not in Airplane Mode) before configuration begins.

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the icon and Airplane mode
should be Off).

3. Alist of available access points will appear.

(© Networks

i Airplane mode
I") y O . Off ]

D]

Available 67 Brightness
Wi-Fi

Guest 2

= | d) RD113-DIR825-2.4GHZ

Notifications Power Keyboard AT ARSI
Openfly
Guest
Change PC settings RD1I4-E
CLEVO-RD18-WRT300N2
pda-rd113-2.4GHz-50Mb

Chamber 12

Hidden network
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Figure F - 27 - WiFi Settings (Charms Bar) & Networks
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Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

When you are connected to the network access point it will display the Connected icon .
Select any connected network and click Disconnect to disconnect from a connected access point.

©No A

(© Networks Networks

Airplane mode
Airplane mode Off [ |

Off |

Wi-Fi

Wi-Fi RD13-DIR.. DIR.. Connected il

RD113-DIR... Connected il

Figure F - 28 - Networks Connected / Disconnect

9. You can click the Airplane Mode button to turn the mode On or Off.
10. If you click on Change PC Settings (at the bottom of Settings in the Charms Bar) you can turn Wireless or
Airplane Mode On/Off (see over).
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11. You need to either use Airplane Mode, or to turn the WLAN module off aboard aircratft.

P C Sett| N g S Airplane mode 7£l;

Wireless Device

) ] Turn this on to stop wireless communication Operation Aboard
Activate Windows off Aircraft
Personalize Wireless devices The use of any portable
Usare Wi elegtronic transmi_ssion

on plewces aboar_d_alrcraft
Notifications is usually prohibited.
Search Make sure the module is
either OFF or in Air-
Share plane Mode (for Win-
dows 8 only) if you are
General using the computer
aboard aircraft.
Privacy
Devices

WEESS

Figure F - 29 - PC Settings (Wireless)
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Desktop Mode

Switch to the Windows Desktop (click the app or use the Windows logo key == + D key combination).
Click the wireless icon ] in the notification area of the taskbar.

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

Select any connected network and click Disconnect to disconnect from a connected access point.

Nogk~wdpE

(®© Networks

Airplane mode
off [ |

Wi-Fi

INEWWIS Guest 2

RD113-DIR825-2.4GHZ

Airplane mode
RD113-DIR855-2.4GHZ-6

off [ |

Openfly
Guest
Wi-Fi RD114-E

CLEVO-RD18-WRT300N2

RD113-DIR... DIR.. Connected il R EAREET

Chamber 12
Hidden network

Figure F - 30 - Windows Desktop Taskbar Notification Area WLAN Connection
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Control Panel
If you arein Category View do the following (see over for Icon View):

1. Open the Control Panel (see “Windows 8 Control Panel” on page F - 8).
2. Click the Network and Internet control panel.
3. Click Connect to a network.

Figure F - 31 - Network and Internet Control Panel

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

Select any connected network and click Disconnect to disconnect from a connected access point.
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If you arein Icon View do the following:

1. Open the Control Panel (see “Windows 8 Control Panel” on page F - 8).
2. Click Network and Sharing Center.

3. Click Change Adapter Settings.

4. Double-click Wi-Fi.

Figure F - 32 - Network and Sharing Center Control Panel

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

Select any connected network and click Disconnect to disconnect from a connected access point.
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Bluetooth Settings (Windows 8)

If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd
Party) then install the driver asinstructed in Chapter 7 (seelinks below).

Usethe Fn + F12 key combination or Control Center button to toggle power to the Bluetooth module.

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

* For 3rd party Bluetooth modules see “ 3rd Party Bluetooth (\VV4.0) Combo Driver I nstallation” on page 7
- 71

* For Intel Bluetooth combo modules see the installation procedure see “ I ntel Bluetooth Combo Driver
Installation” on page 7 - 72.
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Bluetooth Configuration in Windows 8
Y ou can configure a Bluetooth connection as bel ow, however make sure the Bluetooth moduleis turned on (and
not in Airplane Mode) before configuration begins.

Desktop Mode

1. Switch to the Windows Desktop (click the app or use the Windows logo key S@ + D key combination).

2. Click the notification area of the taskbar and double-click the Bluetooth icon E (or click and select Show
Bluetooth Devices).

3. The Devices item in PC Settings will appear.
OR

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click Change PC Settings.

3. The Devices item in PC Settings will appear.

* .6.

. .
D)

Available Brightness

Notifications Power Keyboard

Change PC settings

Figure F - 33 - Bluetooth Taskbar Icon & Change PC Settings (Charms Bar -Settings)
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Click Add a Device.
Double-click the device you want to pair with the computer.

ok

Figure F - 34 - PC Settings (Devices) - Add A Device
6. On first connection the computer will provide you with a pairing code to be entered onto the device.

Figure F - 35 - Enter the Passcode
7. Enter the code into your Bluetooth enabled device and click Yes on the computer to complete the pairing.
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8. You need to either use Airplane Mode, or to turn the Bluetooth module off aboard aircraft.

PC settings

Activate Windows
Personalize

Users
Notifications
Search

Share

General

Privacy

Devices

Ease of Access

Sync your settings

Figure F - 36 - PC Settings (Wireless)
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Turn this on to stop wireless communication

off

Wireless devices

Mobile broadband
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Wi-Fi
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Bluetooth
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Mobile broadband hardware

Chunghwa Telecom

N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft

is usually prohibited.

Make sure the module is
either OFF or in Air-
plane Mode (for Win-
dows 8 only) if you are
using the computer
aboard aircraft.
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To Make your Computer Discoverable to Bluetooth Devices

1.
2.
3.

4.

Switch to the Windows Desktop (click the app or use the Windows logo key == + D key combination).

Click the notification area of the taskbar, click the Bluetooth icon E and click Open Settings.

Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery)
has a tick inside it.

Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has
a tick inside it, if you want to be notified when a Bluetooth device wants to connect.
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Figure F - 37 - Bluetooth Settings
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3G Settings (Windows 8)

If you have included an optional UMTSHSPDA OR UMTS/HSPDA+ based 3G Module (Universal Mobile
Telecommunications System or High Speed Packet A ccess) module (see “ Communication for All Models’ on
page D - 4 for specification details) in your purchase option, you do not require a driver installation for Win-
dows 8. Follow the instructions on page 7 - 48 to install the USIM card (which will be provided by your service
provider), and then use the Charms Bar Wirelessicon to access the 3G network in the same manner as the
WLAN (see overlesf).

NG
A&

Important Notice - 3G Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/Wireless LAN modules
at the same time as this may disrupt radio frequency, and cause interference. When the 3G module is powered on, make
sure that the Bluetooth/Wireless LAN modules are powered off.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited.

Make sure the module is either OFF or in Airplane Mode (for Windows 8 only) if you are using the computer aboard aircraft.
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3G Configuration in Windows 8

Y ou can configure a 3G connection as below, however make sure the 3G module is turned on by pressing the
Fn+  key combination (give the module about 10 seconds to power on) or Control Center button (and not in
Airplane Mode) before configuration begins.

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the icon and Airplane mode
should be Off).

3. Alist of available access points will appear.

(© Networks

Adrplane mode
* Mo R

Off [ |
Available

Mobile broadband

E Chunghwa Telecom

Notifications Power Keyboard

Change PC settings
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Figure F - 38 - WiFi Settings (Charms Bar) & Networks (with Mobile Broadband)
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Any 3G service provider (connection information is usually stored on the USIM card) will appear under Mobile
Broadband.
Double-click any connection icon under Mobile Broadband (or click and click Connect).

Mabile broadband

Chunghwa Telecom

. Connect automatically

Figure F - 39 - Mobile Broadband (Connect)

The system will connect to your network.
A Connected will appear alongside the 3G connection (click the connection to view the timer which indicates
your connected time for the current session).

Mobile broadband

Chunghwa Telecom Connected ?'f:|||

Figure F - 40 - Mobile Broadband (Disconnect)
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8. You can then access the internet, download e-mail etc. as per any internet connection.

9. To disconnect you can select the connection and click Disconnect .
10. You need to either use Airplane Mode, or to turn the Mobile Broadband module off aboard aircraft.

PC settings

Airplane made

Turn this on to stop wireless communication

2N
Ik

Wireless Device

Activate Windows off | | Operation Aboard
Personalize Wireless devices Aircraft
Users Moabile broadband The use of any portable
- on electronic transmission
Notifications wiFi - devices aboard aircraft
On - - o
Serrmelh - is usually prohibited.
Share on — Make sure the module is
) either OFF or in Air-
General Mobile broadband hardware plane Mode (for Win-
Privacy Chunghwa Tefecom dows 8 only) if you are
using the computer
Devices aboard aircraft.

MRS

Ease of Access

Sync your settings
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Figure F - 41 - PC Settings (Wireless)
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EM820W 3G Module PIN Code & Power-Saving

Note that there may be some issues when a PIN Code is set for the EM820W 3G module (if you are unsure of
your module version contact your distributor/supplier) in Windows 8, Mobile Broadband has been turned off,
and the system has resumed from a power-saving state. To prevent any issues it is recommended that you
simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling
the PIN code; for specific instructions on resolving the issue where “Insert a SIM” appears in the connection
see “ Resolving the “Insert a SIM” issue with the 3G Module (Windows 8)” on page 8 - 17.

Disabling a PIN code for a 3G Module

1. Go tothe Charms Bar.
2. Select Settings and then click the WiFi icon.
3. Right-click the 3G connection and select View connection properties.

o €) Networks
W\ e o ©
Chunghwa 100 Brightness Hide estimated data usage

Set as non-metered connection

B O

Notifications Power Keyboard Forget this network

L View connection properties .
Change PC settings . . prop ‘ ‘ TI“
i

Figure F - 42 - WiFi Settings (Charms Bar) & Right-Click Connection to View Properties
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4. Click Security (tab) and click Disable PIN.
5. Enter the PIN number and click Disable PIN and click OK to confirm.
6. Itisrecommended that you do not Enable a PIN for the EM820W 3G module.

Unnamed Mobile Broadband Properties

Subscription IProﬁIe Security

Disabling the PIN will make the device Disable PIN
less secure.,

The PIM has been successfully disabled.

To change the PIN, dick Change FIN. Changs PIN

["show characters

Tries left: 3
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Figure F - 43 - Disable PIN
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